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FOREWORD
Ghana’s new Senior High School Curriculum aims to ensure that all learners achieve 
their potential by equipping them with 21st Century skills, knowledge, character 
qualities and shared Ghanaian values. This will prepare learners to live a responsible 
adult life, progress to further studies and enter the world of work. This is the first 
time that Ghana has developed a Senior High School Curriculum which focuses on 
national values, attempting to educate a generation of Ghanaian youth who are 
proud of our country and can contribute effectively to its development.

The Ministry of Education is proud to have overseen the production of these Learner 
Materials which can be used in class and for self-study and revision. These materials 
have been developed through a partnership between the Ghana Education Service, 
teacher unions (Ghana National Association of Teachers- GNAT, National Association 
of Graduate Teacher -NAGRAT and the Coalition of Concerned Teachers- CCT) and 
National Subject Associations. These materials are informative and of high quality 
because they have been written by teachers for teachers with the expert backing of 
each subject association.

I believe that, if used appropriately, these materials will go a long way to 
transforming our Senior High Schools and developing Ghana so that we become 
a proud, prosperous and values-driven nation where our people are our greatest 
national asset.

Haruna Iddrisu MP

Minister for Education
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ICTS IN SOCIETY
Organising, Managing and Presenting Information Using 
Essential Productivity Tools

INTRODUCTION

This section is a continuation of year one activities, that is designed to help improve 
your understanding of the use of ICT in society. The section introduces you to 
spreadsheets which will enable you to understand how to use programs like Microsoft 
Excel to work with data. You will understand basic parts like cells, rows, and columns, 
which make up the spreadsheet application layout.

You will learn how to use formulas and functions to do calculations, such as adding up 
numbers or finding averages and also explore how to organise your data by sorting and 
filtering it. You also will learn how to use charts and graphs to help you visualise your 
data, making it easier to see trends and comparisons.

Learning spreadsheets is very essential in our everyday life, they help you manage 
information better and makes tasks like budgeting or project planning much easier.

KEY IDEAS

•	 Basic Functions and Formulas: This helps you perform calculations and analyse data 
quickly and easily in a spreadsheet. Just remember to start a formula or function with 
the equal sign (=), choose a function, and reference the cells you want to use. We will 
learn how to navigate and manipulate cells, rows, and columns, starting with simple 
formulas like SUM, AVERAGE, MIN, and MAX. as well as understand relative vs. 
absolute references (e.g., A1 vs. $A$1).

•	 Charts and Visualisation: These tools in Excel help turn numbers into easy-to-
understand pictures. It involves using different types of charts to display your data 
clearly, making it easier to see trends and comparisons.

•	 Data Analysis Tools: These tools help you understand and summarise your data 
in Excel. Tools like pivot tables, sorting, filtering, and functions are used to analyse 
information, and create charts to visualise your findings.

•	 Data Organisation: Organising data in Excel helps you keep things neat and find what 
you need quickly. The use of sorting, filtering, validation, tables, and grouping helps to 
manage your data effectively.

•	 Formatting: Formatting in Excel helps make your data clearer and more visually 
appealing. It involves the use of font styles, colours, borders, and alignment to improve 
the overall look of your spreadsheet. Conditional formatting makes use of rules to format 
cells based on their values (e.g., highlighting duplicates).
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SPREADSHEET APPLICATION
In Year one, you were introduced to spreadsheet applications. You were taken through 
how to launch Microsoft Excel and also touched on the various components of the 
Microsoft Excel interface. In this lesson, we shall again revisit certain features of 
Microsoft Excel.

A spreadsheet application is an application program designed for organising, 
analysing, and storing data in tabular either in rows or in columns. A spreadsheet 
application is mainly used for numerical analysis and data organisation. Some common 
examples of spreadsheet application include; Microsoft Office Excel, Quattro Pro, VP 
plan, Smart Cracker, Lotus 1,2,3, Visi Calc, Super Calc, Corel Calculate, Open Office Calc, 
Libre Office Calc,

Activity 1.1 Launching Microsoft Excel

There are so many ways to launch Microsoft Excel, which includes the use of 
the icon on the taskbar, the use of the icon on the desktop, the application in the 
start menu, etc. Use the skills gained in your year one on how to open a program 
to launch MS. Excel using the “Search bar”. After successfully launching the MS 
Excel, Figure1.1 will be displayed.
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Components of the Microsoft Excel Window/
Interface

Figure1.1: Microsoft Excel Window/Interface

Some commonly used features of the excel window
Table 1.1: Features of Excel Window

S/N NAME FUNTION

1. Auto Sum It is a special button found on the formula bar which is used for 
summation/addition of numbers automatically.

2. Name Box It is the rectangular area at the top left corner of the worksheet in the 
Excel which displays the cell reference or the selected cell (Active 
cell).

3. Active Cell This is the selected cell ready to receive data.

4. Row It is the horizontal portion of a cell on a worksheet. Cells are 
represented by numbers.

5. Column It is the vertical portion of a cell on a worksheet. Columns are 
represented by letters.

6. Status bar It is the bar on top of the task bar. This bar displays the views and the 
zoom tool as well as the state of the workbook.
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7. Horizontal 
Scroll bar

It is the bar that assists the user to view hidden portion of a page 
or file. The user should just press and hold down the left mouse 
button on the bar and move either in left or right direction with the 
intention to view a hidden portion of a page or file.

8. Cell Cell is the area or region created by the intersection of rows and 
columns on a worksheet. In naming a cell, the column letter comes 
first followed by the row figure. Examples of cell names can be; A6, 
V1, B2, B3, C8, P12, etc.

9. Vertical 
Scroll Bar

It is the bar that assists the user to view a hidden portion of a page or 
document vertically. The user should just press and hold down the 
left mouse button on the bar and move either up or down with the 
intention to view a hidden portion of a file.

10. Worksheet 
Tabs

It is a small label at the bottom of an Excel workbook that represents 
a single worksheet.

11. Formula Bar It is a space opposite the name box of the worksheet where you can 
see and enter data or formulas for the selected cell.

Some terminologies in Excel
Table 1.2: Excel Terminologies

S/N TERM EXPLANATION

1 Worksheet It refers to the electronic page in a workbook made of cells. Worksheet 
is the page on which a user works at a given time. The page is made up 
of series of cells.

2 Workbook It refers to an electronic file which contains two or more worksheet in 
them.

3 Graph Graph is another important feature of Excel application. Graph s in 
Excel refers to a diagram or a chart which represents collected data 
or information diagrammatically or pictorially in excel window or 
worksheet.

4 Range It refers to a group of specified or selected adjacent cells on a work 
sheet. It can also be explained as a sequence of adjacent cells on a 
worksheet.

5 Cell 
Reference

It refers to the unique name of a cell which is made of column letter 
and Row number. Example of cell reference are, A1, G4, K23, K5.

Workbooks
A workbook in Excel is a collection of worksheets. This means that two or more 
worksheets forms a workbook. Each worksheet is like a page where you can enter 
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and organise data, perform calculations, and create charts. Think of a workbook as a 
notebook, where each sheet is a different page for your information.

Figure 1.2: Workbook

From Figure 1.2 Workbook, it can be seen that, the window has three worksheets on 
the sheet tab. This means the whole window is a workbook.

Features of Excel Workbooks
Workbooks in Microsoft Excel serve as essential tools for managing, organising, and 
analysing data across various professions and industries. Here are some key uses and 
purposes of workbooks in Excel.

1.	 Workbooks help organise and manage information, making it easy to find and 
work with data.

2.	 Workbooks allow you to do advanced calculations and analyse data, helping to 
make better decisions and find useful insights.

3.	 They help with tasks like planning budgets, predicting future costs, and creating 
financial models accurately.

4.	 Workbooks make reports and presentations clear and neat, making it easier to 
share and understand information.

Uses of Excel Workbooks
1.	 It is used for numerical analysis.

2.	 Spreadsheet applications are used for accounting and financial analysis.

3.	 Spreadsheet applications such as Microsoft Excel is used for sales management.

4.	 They are used in tax preparation.
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5.	 Spreadsheet application is used for budgeting.

6.	 Spreadsheet application such as Microsoft Excel is used for record keeping.

7.	 Spreadsheet application is used for statistical analysis.

8.	 Spreadsheet application is used for data analysis (examination result).

How to create and manage workbooks
Creating an Excel workbook is easy is fun to do! Now, let us look at how you can do it 
in simple steps:

1.	 Start by opening the Excel program on your computer.

2.	 Create a New Workbook:

a.	 If you see a welcome screen, click on “Blank Workbook.”

b.	 If you are already in Excel, go to the top left corner and click on “File,” then 
select “New” and choose “Blank Workbook.”

3.	 Give your workbook a name (File name):

a.	 Click on “File” again, then select “Save As.”

b.	 Choose a location on your computer where you want to save it. To do this, 
click on browse to display the “Save As” dialogue box where you can choose 
a desired location.

c.	 Type a name for your workbook in the “File Name” box and click “Save.” 
(see Figure 1.3)

Figure 1. 3: “Save As” Dialogue Box
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Note
Files in excel are by default named as “book”, so you can have book1, book2, etc. 
depending on the number of new workbooks opened. When you save your file with a 
name, the default name changes to the new given name.

4.	 Add Worksheets: By default, a new workbook will have one or more worksheets. 
If you need more, click the plus sign (+) next to the existing sheet tabs at the 
bottom of the workbook. See Figure1.4.

Figure 1.4: Sheet Tabs

5.	 Start Entering Data: Click on any cell to start typing your data. You can use the 
formula bar to enter formulas if needed.

6.	 You can press “Ctrl + S” or go to “File” and click “Save.” To save changes made.

Activity 1.2 Comparing workbook and worksheet

1.	 With your understanding on workbook, write two differences between 
workbook and worksheet in your own words.

2.	 Share your response with a peer.

Activity 1.3 Creating a new workbook from start menu

1.	 Click on the Start button to display the start menu

2.	 Locate and click on Microsoft Excel to display the Ms. Excel dashboard or 
start-up screen

3.	 Locate and click on “Blank Workbook” as shown in Figure 1.5.
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Figure 1.5: MS Excel Dashboard or Start-up Screen

4.	 The Microsoft Excel window will be displayed as shown in Figure 1.1.

5.	 Enter data and save.

Activity 1.4 Create a Workbook in Excel from a Template

This activity introduces you to another way of creating a workbook from some 
already existing templates or built-in template.

Instructions: open a workbook and follow these steps to create a new workbook.

Steps:

1.	 Open Microsoft Excel

2.	 Click on the “File” tab to open the backstage view.

3.	 From the list of options, choose “New”. This will take you to the available 
templates.

4.	 Browse or Search for a Template. Excel will display a variety of templates, 
such as Budgets, Invoices, Calendars, Planners, etc. Example, “Simple 
invoice” in Figure 1.6.
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Figure 1.6: Template window

5.	 Click on the template that best fits your needs. A preview of the template 
will appear.

6.	 After reviewing the template, click on “Create” to download the template.

7.	 Customise the Template by editing the workbook to suit your specific needs 
by entering your data, modifying formulas, or customising layouts.

8.	 Once you’ve made your changes, save the workbook.

Open an Existing Workbook in Excel
A computer user can open an existing file from a current window of the same 
application. In this section, we shall look at how to open an existing Excel file from a 
current Excel window.

Saving a Newly Created Workbook
In Excel, we can save a newly created workbook of excel file using several steps. You 
can save the file using keyboard shortcut (Ctrl +S) or using the “Save As” command 
button of the backstage view of the file tab. Though you can explore other ways of 
saving a newly created file, this lesson will take you through how to save Excel file 
using the “file” tab.

Activity 1.5 Opening Existing file

Now let us take this activity to open an existing file from a current excel window.

Instruction: Follow the steps systematically and write down tour observation.
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Steps:

1.	 Click on the “File” tab then, select “Open” to display the backstage view.

2.	 Click on “Browse” command button from the open dialogue box as shown

3.	 Find the storage location of the existing file.

4.	 Select your desired file. Example, “SHS Year 2 LM”

5.	 Click on the “open” button to open the existing file. (You see that, additional 
Excel window will be launched).

6.	 Share your experience on this activity with a peer or group members.

Activity 1.6 Saving a Newly Created Workbook

1.	 Click on the “File” menu.

2.	 From the “Backstage” view, click on “Save As” command.

3.	 Save your work in “2 Science 3” folder on the desktop

4.	 Type your group name for the file in the file name box.

5.	 Click on the “Save” button to save the document.

Figure 1.7: Saving a workbook
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Inserting text in Spreadsheet
Inserting text in a spreadsheet simply means placing or typing information such as 
letters, words, or numbers, data/time, currency, into specific cells within a worksheet. 
Each cell in a worksheet can hold different types of content

Steps to Insert Text in a Spreadsheet
Table 1.3: Inserting text in Excel

SN. Main Point Explanation

1 Open the Spreadsheet Launch Microsoft Excel or Google Sheets on any other 
example of spreadsheet application.

2 Select a Cell Click on the cell where you want to insert the text. Cells 
are identified by their column letter and row number 
(e.g., A1, B2).

3 Enter the Text: Type the text directly into the selected cell (active cell). The 
text will appear both in the cell and in the Formula Bar at 
the top of the spreadsheet.

4 Confirm Entry: After entering the text, press Enter or Tab to move to the 
next cell or click anywhere else on the sheet. The text is 
now inserted.

Figure 1.8: Worksheet containing Data



13

YEAR 2 MULTIMEDIA TOOLS AND APPLICATIONSSECTION 1

Observation
It can be seen that the name of the selected cell “D4” which contains the data “AMA” 
has appeared in the name box while the content of the cell “AMA” has been displayed 
in the formula bar.

How to Enter Numbers, Text, Date/time, Series Using AutoFill
1.	 Entering Numbers

	 Single Number: Type the number in a cell (e.g., 1), then click and drag the 
small square (fill handle) at the bottom right corner of the cell down or across 
to fill adjacent cells with consecutive numbers.

2.	 Entering Text

a.	 Single Text Entry: Type a word or phrase in a cell (e.g., “Apple”), then drag 
the fill handle to copy that text to adjacent cells.

b.	 Repeating Text: If you want to repeat a word, type it in one cell and drag the 
fill handle to fill the adjacent cells.

3.	 Entering Dates/Times

a.	 Single Date/Time: Enter a date (e.g., 01/01/2024) or time (e.g., 12:00 PM), 
then drag the fill handle to fill with consecutive dates/times.

b.	 Custom Series: If you want to create a series (e.g., days of the week), type the 
first few entries (e.g., “Monday”, “Tuesday”) to establish a pattern, then drag 
the fill handle.

4.	 Entering a Series

a.	 Custom Lists: To create a custom series (like months or quarters), type the 
first few entries (e.g., “Q1”, “Q2”), then select them and drag the fill handle 
to continue the series.

b.	 AutoFill Options: After using AutoFill, a small icon appears. Click it to 
choose options like “Fill Series,” “Fill Formatting Only,” or “Fill Without 
Formatting.”

How to Edit and Format a Worksheet
1.	 Editing Cells

a.	 Click on the cell you want to edit.

b.	 Double-click the cell or press F2 to start editing. You can change the text, 
numbers, or formulas.

c.	 To the content of a cell, select the cell and press the Delete key.

2.	 Formatting Cells: Select Cells: Click and drag to highlight the cells you want to 
format.

Change Font: to change font Style and Size: Go to the Home tab and use the 
Font group to change the font type, size, and colour.
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3.	 Cell Background colour

Fill colour: Click on the paint bucket icon in the Home tab to change the 
background colour of selected cells.

4.	 Borders

Add Borders: Use the Borders icon in the Home tab to add borders around cells. 
You can choose different styles.

5.	 Number Formatting

Format Numbers: In the Home tab, use the Number group to format numbers 
as currency, percentages, dates, etc.

6.	 Adjusting Column Width and Row Height

a.	 Auto Fit: Move your mouse to the line between column letters or row 
numbers until it changes to a double arrow. Double-click to auto-fit the 
width or height.

b.	 Manual Adjustment: Click and drag the line to set your preferred width or 
height.

7.	 Merging Cells

Merge Cells: Select the cells you want to merge, then click on the Merge & 
Canter button in the Home tab. This combines them into one larger cell.

Insert and Delete Cells
a.	 Insert a Row/Column: Right-click on a row number or column letter and select 

“Insert” to add a new row or column.

b.	 Delete a Row/Column: Right-click on the row or column and select “Delete” to 
remove it.

Activity 1.7 Differentiating between “Name box” and “Formula bar”

Steps:

1.	 Reflect on what has been learned so far,

2.	 Write a definition for both the name box and formula bar after your reflection 
in step 1.

3.	 Share what you wrote in step 2 with your peers.

Activity 1.8 Creating a file using different data format

In this activity, we will open an existing file and add extra data into it based on 
the following criteria.
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Steps:

1.	 Open the file you created in “Activity 1.6” from the 2 SCIENCE 3 folder.

2.	 Under the column “A” type ten names of your classmates using “General” 
data format.

3.	 In column “B” type the date of birth of the following classmate using “Long 
date” format.

4.	 In column “C” type the amount of money spent by each classmate using 
“Currency” data format.

5.	 Save the newly created document in a given folder on the “Desktop” with a 
different name.

6.	 Discuss the process involved with the class.

In this lesson, you will learn how to create and use functions and formular 
through cell referencing.

Now, let us understand cell references so we can use them in creating functions 
and formulas.

HOW TO CELL REFERENCE IN EXCEL
A cell reference is the name of a specific box (cell) in an Excel worksheet. Each cell has 
a unique address made up of a letter (for the column) and a number (for the row) such 
as A1 or B2. It is also known as cell address or cell name.

When you use a cell reference in a formula or a function, you are telling Excel to use the 
value from that specific box (cell). For example, if you write =A1+B1, Excel will add 
the numbers in those two cells together. Cell references help you perform calculations 
easily and keep your data organised.

Table 1.4: Types of Cell References

S/N TYPES OF CELL 
REFERENCES

EXPLANATION

1 Relative Reference This is the default type. When you refer to a cell (like A1) 
and copy the formula to another cell, the reference changes 
based on the new location. For example, if you copy a 
formula from cell B2 that refers to A2 in cell B3, it will refer 
to A3.

2 Absolute Reference This type locks the cell reference, so it does not change 
when you copy the formula. You use a dollar sign before the 
column letter and/or row number (like $A$1). Regardless of 
where you copy it, it will always refer to A1.
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3 Mixed Reference This combines both relative and absolute references. For 
example, $A1 keeps the column fixed while allowing the row 
to change, and A$1 keeps the row fixed while allowing the 
column to change

These cell references are used in formulas and other calculations once the cell reference

is created. It will be displayed as a regular cell reference in the formula bar

Activity 1.9 Cell Referencing

Now let us take this activity to aid a better understanding of cell reference and put 
them into practice. In this activity you will explore various ways of referencing 
cells in a workbook.

Instructions:

1.	 Go through steps 1-4 below to explore the default cell reference (Relative 
Reference).

2.	 Edit steps 1-4 and list your refined steps in your writing material.

3.	 Go through the written steps to help you explore Absolute and Mixed Cell 
Reference.

4.	 Tabulate the differences between the various ways of referencing cells in 
excel

Steps:

1.	 Open the Excel workbook

2.	 Enter two numbers into two different cells

3.	 In a third cell, create a formula that adds the two cells together using cell 
referencing.

4.	 Change each of the original numbers and confirm that the new total has 
changed.

5.	 Discuss with a peer to see how they got on.

6.	 If you finish early, see if you can create formulas to subtract, multiply and 
divide the same numbers.

Note

Ask your teacher for assistance if you are not able to get the right results after 
going through steps a with friend and try it again
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Formula Using the Arithmetic Operators
A formula in Excel is an expression that calculates the value of a cell. It normally 
includes numbers, operators, cell references, functions, and constants. It is a way to 
perform calculations or analyse data using specific instructions. Formulas always start 
with an equal sign (=). In Excel formulas, standard arithmetic operators are used for 
calculations

Table 1.5: Arithmetic Operators

S/N OPERATOR SIGN OPERATOR NAME

1 + Addition

2 - Subtraction

3 * Multiplication

4 / Division

5 ^ Exponentiation

Components of Excel Formulas
1.	 Operators: These could be arithmetic operators such as (-, +) or comparison 

operators such as (=, >, <)

2.	 Cell References: Refer to the contents or name of specific cells (e.g., A1, B2).

3.	 Functions: Predefined calculations that perform specific tasks (e.g., SUM (), 
AVERAGE (), COUNT (), MAX (), MIN ()).

4.	 Constants: Fixed values used in calculations (e.g., numbers like 10, 3.14).

5.	 Parentheses: It is used to group operations and control the order of calculations 
(e.g., = (A1 + B1) * C1).

Figure 1.9: An example of Formula
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Activity 1.10 Creating formulas

First, we will watch the following video: Excel Formulas and Functions Tutorial

Your teacher will stop after each formula, as a group, discuss what you could use 
these formulas to do.

Now, let us take this activity to create formulas and perform basic calculations in 
Excel ourselves. You are required to use the given table to create your worksheet.

Steps:

1.	 Open Excel and create a new worksheet with data in Figure 1.10: Sample 
Excel Worksheet with data.

Figure 1.10: Sample Excel Worksheet with data

2.	 Create a Formula to calculate the total score for each students using 
arithmetic operator.

3.	 Test your formulas by changing the values in the total score of students in 
some subjects and observe how the total scores update automatically.

4.	 Save your work in a chosen location with your surname as the file name.

5.	 Write down any observations you make about how the changing values in 
the subject scores affects the total scores

6.	 Share your observations in the class to discuss how it worked and any 
alternatives.

Functions
Functions in Excel are built-in (ready-made) formulas used to perform calculations. 
These functions make it easier to perform calculations and analyse data in Excel. For 
example, if you are to add values in cells ranging from A1 to A20, a function can be 
used to reduce the stress of repeating individual cells in the formula. So instead of 
=A1+A2+A3+A4+A5…… A20, you can use =SUM (A1:A20) to find the total of 
values in cell A1 to A20.

Table 1.6: Key Point about Functions
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s/n Key Point Explanation Example

1 Equal sign It indicates the start of a formula 
or function in Excel. When you 
type = at the beginning of a cell, 
Excel understands that you are 
entering a formula or function, 
and it will calculate the result 
based on the expression that 
follows.

=PRODUCT(B5, A5): with 
the equal sign beginning this 
function, excel understands that 
you want to multiply values of 
B5 and A5 so it will calculate the 
result for you.

2 Function 
name

It is the word you use to tell 
Excel the kind of calculation or 
task you want to perform. Each 
function name represents a 
specific action

= SUM (A1:A10): “SUM” is a 
function name for addition. This 
function formula will add all 
values from A1 to A10.

2 Arguments These are the inputs you provide 
to the function, such as numbers, 
cell references, ranges, or text

Some functions require only 
one argument while others take 
multiple arguments.

=AVERAGE (M1:M10): A range 
of cells from M1 to M10 (the 
numbers for which you want to 
find the average).

=IF (B1 > 50, “Pass”, “Fail”): in 
this argument, excel will check if 
B1 is greater than 50 then record 
pass else it will record fail

Table 1.7: Types of Functions

Types Examples Explanation

1. Mathematical 
Functions

=SUM(B1:B12) Adds up values in B to B12

=AVERAGE(B1:B12) Calculates the average of 
numbers

=PRODUCT(B1, B1) Multiplies values in B1 and B12

=SQRT(D4) It will find the square root of 
the value in cell D4.

2 Statistical 
Functions

=MAX(G1:C6) Gives you the highest number 
from G1 to G6.

=MIN(D1:D5) Shows the smallest number 
from D1 to D5.
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=COUNT(C1: D12) This will count all the number 
of cells (it will count only 

numbers) specified C1 to D12

3 Text 
Functions

=CONCATENATE(A1, 
“ “, B1)

Combines the text in A1 and B1 
with a space in between.

=UPPER(D3) Changes text from lowercase letters 
in cell D3to uppercase letters.

4 Logical 
Functions

=IF(D5 > 50, “Pass”, 
“Fail”)

Checks if D1 is greater than 50 and 
returns “Pass” or “Fail.”

=AND(G1 > 0, G1 < 100) returns TRUE if G1 is between 0 
and 100.

5 Date and Time 
Functions

=TODAY() Returns the current date. This 
function will show today’s date.

=DATEDIF(A1, B1, “D”) It finds the number of days between 
the dates in A1 and B1. This 
function calculates the difference 
between two dates

Figure 1.11: Example of Function

Activity 1.11 Creating and using Functions

In this activity, we will create a continuous assessment tracker for students in 
your group and Excel functions to calculate total scores, averages, and grades.

Instructions
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1.	 Open Excel and create a new worksheet and label the columns as follows:

a.	 A2: “Student Name”

b.	 B2: “Assessment 1”

c.	 C2: “Assessment 2”

d.	 D2: “Assessment 3”

e.	 E2: “Total Score”

f.	 F2: “Average Score”

g.	 G2: “Grade”

2.	 Input Sample Data:

a.	 In column A, enter names of students in your group.

b.	 In columns B, C, and D, input scores for each assessment.

3.	 Calculate Total Score: In cell E3, enter the formula to calculate total score 
and drag the fill handle down to copy the formula for all students.

4.	 Calculate Average Score: In cell F3, enter the function to calculate average 
score and drag the fill handle down to copy the function for all students.

5.	 Assign Grades: In cell G3, use a nested IF function to assign a grade based on the 
average score and drag the fill handle down to apply this formula to all students. 
Example=IF(E3>=90, “A”, IF(E3>=80, “B”, IF(E3>=70, “C”, IF(E3>=60, 
“D”, “F”))))

6.	 Calculate Class Averages: In the row after the last name, calculate the group 
average for each assessment

7.	 Present your work for peer assessment and make corrections where 
necessary.

Note

You can expand this assessment tracker by adding more assessments, additional 
criteria, or even using advanced functions like VLOOKUP for more complex 
grading systems.

Activity 1.12 Comparison between formulas and functions

Now that you have been able to create and use both formula and functions in 
Excel, let us take this activity to enable you to identify the differences between 
formula and functions

This activity is to help you clearly differentiate between functions and formulas 
in Excel. It will reinforce your understanding through a structured comparison, 
making it easier to remember the unique characteristics of both formulas and 
functions.

Steps:
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1.	 Write out five characteristics of formula with examples learned in this lesson

2.	 Write five characteristics of functions with examples learned earlier in this 
lesson

3.	 Complete Table 1.8 to clearly state the differences between formula and 
function.
Table 1.8: Difference between Formula and Function

1 Key Aspect Formula Function

1 Definition

2 Usage

3 Syntax

4 Examples

5 Complexity

6 Return Type

4.	 Discuss the outcome of your tables with a peer for review and share views 
on each other’s work.

DEBUGGING AND TROUBLESHOOTING 
FORMULAS AND FUNCTIONS
Hello learners, welcome to another interesting lesson on Microsoft Excel.

In our previous lessons, we discussed creating and using formulas and functions to 
perform calculations. When your formulas do not run as expected, then it is possible it 
contains errors or bugs.

Debugging and troubleshooting formulas are processes used to identify and fix problems 
in your calculations, especially in MS Excel and other spreadsheets applications

Debugging
It is checking your work to see if the formula created is working. If a formula is not 
giving you the right result, you look at it closely to find mistakes. Debugging involves;

1.	 Making sure the formula points to the right cells and avoiding incorrect cell 
referencing.

2.	 Ensuring you are using the right math functions (like adding instead of 
subtracting) by avoiding wrong operators.
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3.	 Syntax errors: Looking for missing parentheses or other typing mistakes in 
your formula (Syntax errors).

Debugging Techniques
1.	 Check for Errors: Look for error messages in cells, such as #DIV/0!, #N/A, or 

#VALUE!. These indicate specific issues that need to be addressed.

2.	 Use the Formula Bar: Click on a cell with a formula to see the entire formula 
in the formula bar at the top. This helps you review and edit the formula easily.

3.	 Evaluate Formula Tool: Go to the Formulas tab and select Evaluate Formula. 
This tool allows you to see how Excel calculates the formula step by step, which 
can help you spot mistakes.

4.	 Break Down Complex Formulas: If a formula is complicated, break it into 
smaller parts. You can create separate cells for each part of the calculation to see 
where the error occurs.

5.	 Check Cell References: Make sure you are referencing the correct cells. If 
you copy a formula, check for relative and absolute references (using $ signs) to 
ensure they behave as expected.

6.	 Use Functions for Testing: Use functions like IFERROR() to handle errors 
gracefully. For example, =IFERROR(A1/B1, “Error”) will return “Error” instead 
of an error message if there’s an issue.

7.	 Highlight Errors: Use conditional formatting to highlight cells with errors. 
This can make it easier to spot problematic areas in your worksheet.

8.	 Check Data Types: Ensure the data types are correct. For example, if you’re 
trying to perform math operations, make sure the cells contain numbers, not 
text.

9.	 Use the Trace Precedents and Trace Dependents Tools: These tools can 
show you which cells affect a formula (precedents), or which formulas depend 
on a cell (dependents). You can find them in the Formulas tab.

10.	Consult the Help Function: Use Excel’s built-in help feature or search online 
for specific functions if you are unsure how they work or what might be going 
wrong.

Troubleshooting
It is about finding out why a formula is not working as expected. To find out why your 
formula is not working as expected, you should;

1.	 Test the formula by breaking it down into parts to see which part is not working.

2.	 You should check the data type in the formula. Make sure you are using the 
right kinds of data for example using text instead of number can result in error.

3.	 Look for hidden issues because sometimes, formatting or hidden characters can 
cause problems during calculation.
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Troubleshooting Steps
1.	 Look for error messages like #DIV/0!, #N/A, or #VALUE!. These indicate specific 

problems. For example, #DIV/0! means you’re trying to divide by zero.

2.	 Click on the cell with the formula and check the formula bar. Make sure the 
formula is written correctly and that all necessary parts are included.

3.	 If the formula is complex, break it into smaller parts. Put each part in its own 
cell to see where it might be going wrong.

4.	 Ensure you’re referencing the correct cells. If you copied the formula, check that 
the references are still appropriate (relative vs. absolute).

5.	 In the Formulas tab, click on Evaluate Formula. This tool lets you see how 
Excel calculates the formula step by step, helping you pinpoint where the issue 
is.

6.	 Ensure the data types are correct. For instance, if you’re adding numbers, make 
sure the cells contain numerical values, not text.

7.	 Highlight cells with errors using conditional formatting. This makes it easier to 
spot issues in your worksheet.

8.	 Sometimes, hidden spaces or characters can cause problems. Use the TRIM() 
function to remove extra spaces from text.

9.	 Create simple test cases or use known values to see if the formula works as 
expected. This can help you isolate the problem.

10.	 If you are still stuck, look for help online or ask a colleague. Sometimes a fresh 
perspective can make all the difference.

Activity 1.13 Characteristics of Debugging and Troubleshooting Formulas

Instructions: Match each characteristic (1-8) to either Debugging or 
Troubleshooting by shading the blank column next to each characteristic.
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Table 1.9: Characteristics of Debugging and Troubleshooting

Characteristics Debugging Troubleshooting

1.	 dentifying specific errors in formulas

2.	 Checking for incorrect cell references

3.	 Analysing the overall system for 
issues

4.	 Finding out why something isn’t 
working

5.	 Testing different parts of a formula

6.	 Looking for patterns in repeated 
problems

7.	 Correcting syntax errors in formulas

8.	 Ensuring all data types are 
appropriate

Some common errors in using formula and 
functions in Excel
Table 1.10: Formula Errors

Error Description

1 #DIV/0! It occurs when you try to divide a number by zero or by an empty cell. In 
simple terms, it means you’re trying to perform a calculation that doesn’t 
make sense because you can’t divide something into zero parts.

2 #NUM! This error happens when a formula has invalid numeric values. This 
means there’s something wrong with the numbers being used in the 
calculation.

If a calculation results in a number that is too large or too small for Excel 
to handle, it will also show #NUM!

3 #REF! This error means that, a formula is trying to use a cell reference that is 
no longer valid. This usually happens if you have deleted a cell or a row/
column that the formula was pointing to.
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4 #NAME? If you type a function name incorrectly (like writing =SUMM(A1:A10) 
instead of =SUM(A1:A10)), Excel doesn’t know what you mean.

If you use a name for a cell or range that hasn’t been defined, Excel can’t 
find it.

If you forget to put quotes around text in a formula or you use wrong 
quotes.

5 #VALUE! You are trying to perform a calculation with text instead of numbers. For 
example, if you have =A1 + “hello” and A1 contains a number, Excel 
can’t add a number and text together.

Improper Arguments: If a function expects a number but you give it 
something else, like a cell with text, it will show this error.

6 #N/A This shows up when a formula cannot find a value it’s looking for. This 
commonly happens with lookup functions, like when you use VLOOKUP 
or HLOOKUP, and the item you are searching for doesn’t exist in the 
specified range.

Activity 1.14 Finding solutions to errors

This activity is to help identify errors in formulas and what to do to solve them.

Instructions:

1.	 Carefully study the diagram in Figure 1.12

2.	 Fill each red box with the error that each description will resolve

Figure 1.12: Solutions to Formula Errors
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Activity 1.15 Identifying and fixing errors in using formula in excel

1.	 Open an existing sample Excel file that you’ve been provided by your teacher 
containing errors.

2.	 Locate and list all the errors you find in the sample file.

3.	 For each identified error look at the meaning of the error and write down 
possible solutions for each error type.

4.	 Fix the errors in the sample file with a friend based on what you wrote in 
step 3.

5.	 Discuss the errors and the solutions found.

6.	 Share different approaches to resolving the errors.

Note

If after taking this activity you still have challenges fixing some of the errors, ask 
your teacher to guide you to do it right and try again on your own.

CREATING GRAPHS AND CHARTS IN EXCEL
Good job on completing the lesson on debugging and troubleshooting formulas in 
Excel. In this lesson, we would look at how data can be represented in a visual form to 
make it more appealing

Purpose of Using Graphs and Charts
Visual representations of data in Excel are ways to turn numbers and information into 
pictures, making it easier to understand and analyse.

Types of Visual Representations
1.	 Graph: A graph is a visual representation of data that helps you understand 

relationships, trends, and comparisons at a glance. It uses various graphical 
elements like lines, bars, or points to display your data.

2.	 Chart: A chart is a visual tool used to present data in a structured format, often 
using bars, lines, or slices to compare different categories or show parts of a 
whole.

3.	 Infographics: Combine text, images, and data visualisations to communicate 
information engagingly and effectively.
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Table 1.11: Examples of Graphs and Charts

Type Examples Description

Graph Line Graph Shows trends over time by connecting data points with 
lines.

Bar Graph Uses horizontal or vertical bars to compare different 
categories or values.

Column Graph Similar to a bar graph but displays data in vertical columns.

Pie Chart Represents parts of a whole, with each slice showing a 
percentage of the total.

Scatter Plot Displays values for two different variables, showing how 
they relate to each other.

Histogram shows the frequency distribution of a set of continuous data

Charts Bar Charts Show comparisons between different categories using bars.

Line Charts Display trends over time with lines connecting data points.

Pie Charts Show parts of a whole, with slices representing percentages

Benefits of Using Graphs and Charts in Excel
1.	 Easy Understanding: They make complex data easier to understand by turning 

numbers into visuals, allowing you to see trends and patterns quickly.

2.	 Better Comparisons: Graphs and charts help you compare different sets of 
data side by side, making it easier to spot differences and similarities.

3.	 Highlight Key Information: Important data points stand out in a visual 
format, so you can quickly identify highs, lows, and significant changes.

4.	 Engaging Presentation: Visuals are more engaging than plain numbers and 
texts, making it easier to grab your audience’s attention during presentations or 
reports.

5.	 Improved Decision-Making: By visualising data, you can make informed 
decisions more easily, as it helps you see the bigger picture and understand the 
implications of the data.

6.	 Timesaving: Quickly assessing data through visuals saves time compared to 
reading through rows of numbers, allowing for faster analysis.

7.	 Effectiveness: They improve the effectiveness of communication by conveying 
messages clearly and concisely
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Factors to consider when choosing charts and for data
When choosing charts for visualisation in Excel, it’s important to consider a few key 
factors to ensure the data is effectively communicated. The factors to be considered 
include;

1.	 Type of data

2.	 Purpose of the chart or graph

3.	 Number of data points

4.	 Data relationship

5.	 Clarity

6.	 Simplicity, etc.

Identifying and Selecting the Most Suitable Chart Types
1.	 Understand the data to determine what type of data you have (categorical, 

numerical, time-series).

2.	 Define the purpose of what you need to communicate (comparison, distribution, 
relationship, trend).

3.	 Choose the chart that best fits the data and the intended message. Figure 1.13 
shows the “chart” section of the insert tab.

Figure 1.13: Charts Views

Note

Bar charts compare categories, and Pie charts show parts of a whole. Line charts show 
trends over time, and Scatter plots show relationships between variables. You can 
therefore choose any of the available charts that best suit your purpose.

Creating Charts in Microsoft Excel

1.	 Open your excel workbook and enter your data

2.	 Select the data for which you want to create a chart.

3.	 Click INSERT > Recommended Charts.



30

YEAR 2 MULTIMEDIA TOOLS AND APPLICATIONSSECTION 1

4.	 On the Recommended Charts tab, scroll through the list of charts that Excel 
recommends for your data, and click any chart to see how your data will look.

5.	 If you don’t see a chart you like, click All Charts to see all the available chart 
types.

6.	 When you find the chart you like, click it > OK.

7.	 Use the Chart Elements, Chart Styles, and Chart Filters buttons command at 
the upper-right corner of the chart to add chart elements like axis titles or data 
labels, customise the look of your chart, or change the data shown in the chart.

Activity 1.16 Creating Pie Chart

Instruction: Follow these steps to create a pie chart in excel.

Steps:

1.	 Launch Microsoft Excel application.

2.	 Type your data in your worksheet using the data in Figure 1.14.

Figure 1.14: Sampe Excel Data for Pie Chart

3.	 Select the data range that you want to turn into a pie chart, including 
headings

4.	 Go to the Insert tab on the Excel ribbon.

5.	 In the Charts group, click on the small arrow to Pie chart icon to display the 
various pie chart styles.
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Figure 1.15: chart Group Icons

6.	 Click on the specific pie style you like, and Excel will automatically create a 
visual representation of the data you selected in step 2.

Figure 1.16: Pie Chart Styles

7.	 Save your work and share your experience with a peer
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Activity 1.17 Creating a Column

1.	 Open the program (MS Excel)

2.	 Enter your data. (Use Figure 1.17)

Figure 1.17: Sample Excel data for column chart

3.	 Select your data (use total score for your column chart)

4.	 Go to the Insert tab on the Excel ribbon.

5.	 In the Charts group, click on the small arrow to column chart icon to display 
the various column or bar chart styles.

Figure 1.18: Bar or Column Chart Icon
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6.	 Click on the specific style you like, and Excel will automatically create a 
visual representation of the data you selected in step 2.

Figure 1.19: Column chart styles

MANIPULATION THE CHARTS
Manipulating charts in Excel allows you to customise them to better display your data. 
It makes your charts more informative and visually appealing, making it easier for your 
audience to understand the data. This involves changing the chart type, adjusting the 
data range, formatting axes, adding labels, and customising colours or styles to make 
the chart more informative and visually appealing

Customise the Title of the chart
1.	 Click on the default title “Chart title” of the chart. This will select the text in the 

textbook.

2.	 Erase the text in the name textbox “Chart title”

3.	 Type your desired title for the chart. Example, “TERM 2 EXAMS SCORE OF 
STUDENTS”

4.	 The charts shall then bear the customised name as shown in Figure 1.20.
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Figure 1.20: Customised Chart Title

Giving Colour to the Columns
1.	 Click on the column chart to activate it. The Chart Filters buttons appear beside 

it

2.	 Locate and click on the chart styles.

3.	 Click on the “Colour” button to display the colour pallet.

4.	 Select your desired colour to be applied to the chart.

5.	 The chart will then bear the customised colour as in Figure 1.21.

Figure 1.21: Colouring Charts

Activity 1.18 Creating Bar Charts

1.	 Having gone through how to use the style button of the “Chart Filters” 
buttons; pair with your peer and perform the task below using the guided 
instruction.
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2.	 Create an Excel file of ten students and indicate their names. Remember to 
add their ages using figures rather than numerals.

3.	 Create a bar chart with the text data.

4.	 Use the “Style” button from the “Chart Style” view to modify the shape(style) 
chart.

5.	 Share your approach with other groups.

6.	 Activity 1.19 Creating a Line Chart

7.	 In the existing workbook, click on the “New Sheet” button beside the Sheet1 
to add additional worksheet

8.	 On the new worksheet, create an Excel file with the names of seven learners 
under column A.

9.	 In column B, type their corresponding ages

10.	 Select the data (ages of learners) in column B.

11.	 Go to the Insert tab on the Excel ribbon.

12.	 In the Charts group, choose the type of chart (Line chart).

13.	 Click on the specific line chart style you like, and Excel will automatically 
create a visual representation of the text data.

Note

Your chart should look similar to or same as Figure 1.22 Sample of a line chart. If 
your chart does not look similar to or same as Figure 1.22, go over the steps again 
to get it right. A Peer who had it right could guide you.

Figure 1.22: Sample of a line chart
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Activity 1.20 Customising Style of the Line chart

1.	 Click on the column chart to activate it. The Chart Filters buttons appear 
beside it

2.	 Locate and click on the chart styles.

3.	 Click on the “Style” button to display the style options.

4.	 Select your desired style for the line chart.

Figure 1.23: Customised Line Chart Window

Saving the Chart
Saving a document is an important activity in file creation. It helps prevent loss of data 
in case of power failure or system crashes. It allows you to access and edit your work 
later without needing to start over. A saved document can also be easily shared with 
others for collaboration or future use.

Activity 1.21 Saving a Chart as a PDF File

Instruction:

1.	 Use your knowledge on how to save a newly document to save the excel file 
using the Save As command from the “Backstage view”

2.	 Choose PDF from the “Save as type” option in the “Save As” dialogue box

3.	 Choose a storage location for the file and assign it a desired name.

4.	 Share your experience in performing this activity with a peer
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SORTING AND FILTERING DATA IN EXCEL
Welcome to another interesting lesson in Excel. In this lesson you will deal with sorting 
and filtering in Excel.

Sorting
Sorting in Excel simply means arranging data in a specific order to make it easier to 
understand and analyse. You can sort data in ascending (A to Z or smallest to largest) 
or descending (Z to A, largest to smallest) order based on a particular column. For 
example, you can sort a list of learners’ names alphabetically or arrange sales figures 
from highest to lowest.

Benefits of Sorting Data
1.	 Organises data: Makes it easier to find information when data is arranged in a 

logical order.

2.	 Improves readability: Helps users quickly understand trends, such as highest 
to lowest sales or alphabetical lists.

3.	 Facilitates comparison: Sorting allows for easy comparison between data 
points by grouping similar items together.

4.	 Speeds up analysis: Sorting helps identify outliers, patterns, or trends faster

Filtering
Filtering in Excel is a way to display only the data you want to see while hiding the rest. 
It helps you to focus on specific information within a larger dataset.

Benefits of filtering data
1.	 Focuses on relevant data: Helps you view only the specific data you need, 

making large datasets easier to work with.

2.	 Saves time: By narrowing down the information, filtering allows you to find 
what you’re looking for quickly.

3.	 Improves data analysis: Filtering helps in isolating key data points for deeper 
analysis without distractions from irrelevant information.

4.	 Simplifies reporting: You can create focused reports by displaying only data 
that meets certain conditions, making insights clearer.
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Activity 1.22 Sorting and filtering

1.	 Consider the importance of sorting and filtering of data in Microsoft Excel. 
As an ICT student, you were given different textbooks made of different 
subjects and classes to sort and filter.

a.	 Indicate any two ways you will sort the textbooks.

b.	 What way will you filter the books to your desired condition or criteria?

c.	 Outline two benefits you may have when you sort and filter a given set 
of books in the table below.

Table 1.12: Sorting and filtering

SN Benefits of Sorting Benefits of Filtering

Difference between Data Sorting and Data 
Filtering
Table 1.13: Differences between sorting and filtering

SN Data Sorting Data Filtering

1 Organises data in a specific order 
(ascending or descending) to 
make it easier to navigate and 
analyse.

Displays only the rows that meet specific 
criteria, hiding the rest of the data 
temporarily.

2 Rearranges the entire dataset 
according to the chosen order 
but keeps all data visible

Hides data that doesn’t meet the criteria, 
showing only the filtered portion.

3 Applied to organise data 
based on a single or multiple 
columns (e.g., sorting names 
alphabetically or prices from low 
to high).

Applied to focus on specific data by 
conditions (e.g., displaying only products 
above a certain price or students who 
scored above 80%).

4 Changes the position of the data 
in the worksheet, affecting the 
entire dataset.

Does not change the order of data but 
temporarily hides rows that do not match 
the filter criteria.

5 All data remains visible, just in a 
different order.

Only the data that meets the set conditions 
is visible; other data is hidden.
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Types of Sorting
There are different ways you can sort your excel data. Alphabetic data can be sorted 
either A-Z or Z-A while numeric data can be sorted either Small –large or large – small.

1.	 Alphabetical Sorting: Arrange text data in alphabetical order, either AZ 
(ascending) or ZA (descending).

2.	 Numerical Sorting: Orders numerical data from smallest to largest (ascending) 
or largest to smallest (descending).

3.	 Date Sorting: Organises date and time data from oldest to newest (ascending) 
or newest to oldest (descending).

4.	 Custom Sorting: Uses user-defined lists or criteria to sort data in a specific 
order

Sort Data in Excel Numerically
1.	 Launch Microsoft Excel application and create your desired data using the 

experience gained in the previous lessons.

2.	 Select the range of cells you want to sort. Make sure the data selected are values 
or numbers.

3.	 Click on the drop-down arrow beside the “Sort and Filter” button or tool.

4.	 From the drop-down options, choose your desired sorting command. (Descending 
order).

Note

After going through step 1-5, the selected data will be rearranged from the biggest to 
the smallest.

Figure 1.24: Sorting Numeric Data
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Sort Data in Excel Alphabetically
Alphabetic data sorting simply means sorting label data (non-figure) in a particular 
order. This means that sorting can be applied to numbers. The sorting can either be 
A-Z or Z-A.

How to Sort Data Alphabetically
1.	 Select the range of cells you want to sort. Make sure the data selected are labels 

(alphabetic data.)

2.	 Click on the drop-down arrow beside the “Sort and Filter” button or tool.

3.	 From the drop-down options, choose your desired sorting command. (ascending 
order: A-Z or Descending Z-A)

Figure 1.25: Sorting Alphabetic Data

Activity 1.23 Sorting Data in Excel

Taking this activity aids a better understanding of sorting data in excel workbooks.

Instructions

1.	 Create a workbook with two different worksheets.

2.	 Enter the names of your group members and their ages on each worksheet.

3.	 Change your sheet tabs name (Numbers for sheet 1 and Alphabets for sheet 
2)

4.	 Applying your sorting skills to the data you have created.

5.	 Save your work with your first name.

6.	 Present and explain your work to a peer and the class at large.

Note

Your workbook should look like Figure 1.26
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Figure 1.26: Sorting Practical work

Data Filtering
Filtering in Excel as explained earlier is a way to display only the data you want to see 
while hiding the rest. For example, you can filter a list of products to show only those 
with prices above a certain amount or filter a table to display students who scored 
above 80%. In this case the cells which meet the criteria will show up over those which 
do not meet the set criteria. That is to say that data filtering helps you focus on specific 
parts of your data, making it easier to analyse or find information without changing 
the original data set.

How to filter data in Excel
Now let us look at how we can hide some data sets and show some.

1.	 Select Your Data: First, you click on a cell in your data set, usually a table with 
headers (like names, dates, or numbers).

2.	 Turn on Filter: Go to the “Data” tab and click on “Filter.” This will add small 
arrows to each header.

3.	 Choose What to See: Click on the arrow in the header of the column you want 
to filter. You’ll see a list of options which you can check or uncheck boxes to 
include or exclude specific items. You can also sort the data or set conditions 
(like showing only numbers greater than a certain value).

4.	 View Filtered Results: After you make your selections, Excel will hide the 
rows that don’t meet your criteria, showing only the data you want to see.

5.	 Clear or Remove Filter: To see all your data again, you can click the filter 
arrow and choose “Clear Filter” or turn off the filter completely.



42

YEAR 2 MULTIMEDIA TOOLS AND APPLICATIONSSECTION 1

Filtering Excel Data
1.	 Create your Excel file.

2.	 Select the data range you want to filter (e.g., A3:A9)

3.	 On the Excel ribbon, click on the Data tab.

4.	 In the Sort & Filter group, click on the Filter button. This will display drop-
down arrows to each column header of the selected column.

5.	 Click on the drop-down arrows to each column header to display the ‘Text filter” 
dialogue box.

Figure 1.27: Data Filtering Process

6.	 Click the checkboxes of the cell you want to hide its data to uncheck them 
leaving the cells you want to display unchecked. In this lesson, we shall filter 
data to display names of students with the initial letter “A”.

7.	 Click OK to apply the filter.

Figure 1.28: Data Filtering Dialogue Boxes
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Note: It will be noted that cells which were checked are now hidden leaving those cells 
which were not checked as shown in Figure 1.29.

Figure 1.29: Sample Filtered Data set

ADVANCE DATA FILTERING
In Excel, you can hide certain columns while displaying others by manually hiding 
them. However, if you want to filter multiple columns based on specific data criteria 
while showing only the columns you need, you will use a combination of filters and 
the hide column feature.

Activity 1.25

In this activity, we shall look at how to filter to display learners who had total 
score marks above 230 as shown in Figure 1.30.

Figure 1.30: Sample Date set for Advanced Filter
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Steps:

1.	 Create your worksheet with data from Figure 1.30: Sample Data set for 
Advanced Filter

2.	 Select the column “E” containing the total score of students.

3.	 Click on the “Data” tab to display in views or groups.

4.	 Locate and click on the “Filter” tool. A drop-down arrow appears at the 
column heading of “E”.

5.	 Click on the drop-down arrow at the column heading “E”.

Figure 1. 31: Advance filtering Process

6.	 From the filter option dialogue box, click on “number filter”.

7.	 From the sub-menu, click on “Greater Than” command to display the 
“Custom filter” dialogue box.

Figure 1.32: Custom filter” dialogue box



45

YEAR 2 MULTIMEDIA TOOLS AND APPLICATIONSSECTION 1

8.	 Type or specify your desired value in it.

9.	 Click on “OK” to complete the filtering process.

Figure 1. 33: Custom AutoFilter

Note

It will be noted that, the records (Rows) showing total score of students less than 
230 are hidden as shown in Figure 1.34.

Figure 1. 34: Sample of Advanced filtered data
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Applying Multiple Filters
To apply multiple filters across different columns in Excel, you can combine conditions 
on multiple columns. Let’s use the sample data from Figure 1.35: Sample data set for 
Multiple Filters to apply multiple filters.

Figure 1. 35: Sample Data set for Multiple filtering

Activity 1.26 Applying Multiple Filtering

Instruction: Follow the steps to filter to apply two conditions:(Total score greater 
than 230 and Maths score greater than 60)

Steps to Apply Multiple Filters

Selecting desired data

1.	 Select your entire data range from A3 to E9, including headers and rows 
(names and scores).

2.	 Go to the Data tab in the Excel ribbon.

3.	 Click on the Filter tool, then drop-down arrows will appear next to each 
column header.

Apply the First Filter (Total Score > 230)

4.	 Click on the drop-down arrow next to the Total column (E).

5.	 Select Number Filters, then choose Greater Than.

6.	 In the dialog box that opens, enter 230.

7.	 Click on the OK tab.
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Figure 1.36: Filtering total score column

Apply the Second Filter (Maths Score > 60)

8.	 Now, click on the drop-down arrow next to the Maths column (B).

9.	 Select Number Filters.

10.	 Choose Greater Than.

11.	 In the dialog box that opens, enter 60.

12.	 Click on the OK tab.

Figure 1.37: Filtering Maths score column

Note

This will filter and display only students who have Maths scores above 60 and 
Total scores above 230.as shown in Figure 1.38.
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Figure 1. 38: Multiple filtered data

SAVING WORKBOOK
Saving a file is an important activity in file creation. It helps prevent loss of data in 
case of power failure or system crashes. It allows you to access and edit your work later 
without needing to start over. A saved file can also be easily shared with others for 
collaboration or future use.

Saving A Workbook with the Default File Format
1.	 Click on the “File” menu.

2.	 From the “Backstage” view, click on the “Save As” command.

3.	 Choose a storage location for the file. Example; “Documents”.

4.	 Type your desired name for the File in the file name box. Example: “Year 2 LM”.

5.	 Click on the “Save” tab to save the file.

Figure 1.39: Steps for Saving a Workbook
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Saving A Workbook in Portable Document Format (PDF) 
on an External Drive
1.	 Insert your external drive into the computer

2.	 Click on the “File” menu.

3.	 From the “Backstage” view, click on the “Save As” command.

4.	 Choose the external drive as the storage location. Example: “New Volume G”.

5.	 Type your desired name for the file. Example: “Learner Manual 2”.

6.	 Click on the “Save as type” to display the available file formats.

Figure 1.40: Save As Dialogue Box

7.	 Select your desired file format, example “PDF”.

8.	 Click on the “Save” tab to save the file.

Figure 1.41: Samples File Formats
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Activity 1.27 Saving a workbook

1.	 Use the skills gained in working with workbooks and worksheets to perform 
this activity.

2.	 Save workbooks to a cloud service of the choice of the group (e.g. OneDrive, 
Google Drive, or Dropbox)

3.	 Make sure your computer has internet access

4.	 Discuss benefits of saving a document of cloud storage such as OneDrive or 
Google

5.	 Share your group’s procedure and approach performing this activity with 
other groups.

Printing Worksheets
Printing is the process of making copies of text or images on paper or other materials. 
It usually involves a machine, like a printer, that uses ink or toner to transfer the design 
onto the surface. It is converting a softcopy document into a hardcopy format.

1.	 To print a file in a workbook, the computer user needs to consider the following;

2.	 The paper orientation, whether portrait or landscape

3.	 The paper size to be used. Example, A5, A4, A3, A2, A1, etc.

4.	 The page to print. Whether the active page or selection

5.	 The number of copies to be printed. Etc.

How to Print an Active Worksheet
1.	 Click on the file tab to display the backstage view.

2.	 In the backstage view, click on “Print” to display the print dialogue box.

3.	 Select the printer you want to use if there are more than one printer connected 
to your computer.

4.	 Select the pages you want to print. For the purpose of this lesson, select “Active 
Sheet”.

5.	 Specify the number of copies you need using the “Copies” arrows.

6.	 Select the orientation you want. It defaults, the paper orientation will be 
“Portrait”. Therefore, select, “Landscape” to change the default orientation.

7.	 Indicate the paper size. The default paper size is “Letter”, therefore, select you 
desired paper size, example, A4.

8.	 Click on the “Print” button to issue the print command.
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Figure 1.42: The Print Dialogue Box

Customise Printing Output
Headers and footers

Headers and footers are useful for including additional information such as the 
document title, page numbers, date, etc., at the top (header) or bottom (footer) of 
printed pages. Header allows you to add additional information at the top margin of 
the document page while footer is used to insert additional information at the bottom 
of the page margin.

How to Add and Edit Headers/Footers

1.	 Go to the Insert tab on the Excel ribbon.

2.	 Click on Header & Footer in the Text group.

Figure 1.43: Header and footer
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3.	 Excel will switch to Page Layout view. You can now click to edit the header or 
footer area.

Figure 1. 44: Page Layout View

To Customise Headers/Footers

In the Header & Footer Tools design tab (which appears when you are editing the 
header/footer), you can:

1.	 Insert page numbers: Click on Page Number.

2.	 Insert the date: Click on Current Date.

3.	 Insert the file name or sheet name: Use File Name or Sheet Name.

4.	 Switch between header/footer: Click on Go to Footer or Go to Header to edit 
both areas.

Adjusting Page Breaks

Page breaks control where a new page begins when printing large worksheets.

How to View and Move Page Breaks

1.	 Go to the View tab.

2.	 Click on Page Break Preview. This will show you where Excel automatically 
inserts page breaks.

Figure 1.45: Page Break Preview

3.	 Blue lines indicate where page breaks occur. You can click and drag these lines 
to manually adjust them.
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Figure: 1.46: Page Breaks

Adjusting Print Settings (Page Setup Dialog Box)

The Page Setup dialog box is where you can make fine adjustments to your print 
settings, including scaling, margins, headers/footers, and more.

Manage Print Jobs using Pause, Cancel, and Resume Print Job
Access the Printer Queue

A printer queue is a list of print jobs waiting to be processed by a printer. When 
multiple documents are sent to a printer simultaneously, they line up in the queue in 
the order they were submitted, and the printer processes them one by one.

Accessing Printer Queue

1.	 Open the Control Panel.

2.	 In the Control Panel dialogue box, select Devices and Printers.

3.	 Find the printer you used to send the Excel job.

4.	 Right-click the printer and select open.

5.	 This will open the print queue, showing the list of active print jobs.

Manage the Print Job

In the printer queue, you’ll see the Excel document you sent to print. Here, you can 
Pause, Cancel, or Resume as needed:

1.	 To Pause: Right-click the print job and select Pause. This stops the job 
temporarily.
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2.	 To Cancel: Right-click the print job and select Cancel. This permanently stops 
and removes the job from the queue.

3.	 To Resume: Right-click the paused job and select Resume to continue printing.

Activity 1.29 Printing worksheet

Now, take this activity to assess yourself on what you have learned on printing 
worksheets.

Instructions:

1.	 Open an existing workbook.

2.	 Print Preview your worksheet.

3.	 Issue a print command.

4.	 In your print dialogue box, adjust your print setting.

5.	 Print your document.

6.	 List the steps for performing steps 1 to 5.

7.	 Exchange your write up in step 6 with a peer and go through to print your 
document again.

Note

Where you do not have a printer, your teacher will make available a printer and 
a computer to take this activity. He can also take you on a field trip to a printing 
press to observe how printing is done.

Activity 1.30 Importance of Print Preview.

After going through Activity 1.29, create a flyer to emulate three (3) importances 
of print previewing a document before final printing. Print your flyer for class 
presentation.
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EXTENDED READING
•	 https://www.wallstreetmojo.com/cell-reference-in-excel/

•	 https://www.du.edu.eg/upFilesCenter/sci/1585238926.pdf

•	 https://staff.emu.edu.tr/selirakotoua/Documents/itec106a/itec106%20lab/EXCEL%206.pdf
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REVIEW QUESTIONSREVIEW QUESTIONS

1.	 What is a workbook in a spreadsheet application?

2.	 Differentiate between a workbook and a worksheet in a spreadsheet 
application.

3.	 Explain the purpose of using multiple worksheets within a single workbook 
in spreadsheet software.

4.	 Compare and contrast the advantages and disadvantages of using separate 
workbooks versus multiple worksheets within a single workbook for 
organising data in spreadsheet software.

5.	 Create a comprehensive guide for new users on organising and managing large 
datasets across multiple worksheets within a single workbook in spreadsheet

6.	 How do you start a formula in Excel?

7.	 What is the difference between an absolute cell reference and a relative cell 
reference?

8.	 A spreadsheet contains data on monthly sales figures from January to June for 
different products. Explain how you will use functions to identify the product 
with the highest sales for a particular month?

9.	 What does the error #VALUE! mean?

10.	 What are some ways to troubleshoot a formula that doesn’t give the expected 
result?

11.	 Why might you receive a #N/A error when using a VLOOKUP formula?

12.	 If you notice that a formula returns a #REF! error after moving or deleting 
rows, what steps would you take to restore its functionality?

13.	 What are the basic steps to create a Bar chart in Excel?

14.	 Explain the difference between a Pie chart and a line graph.

15.	 Which chart type would be most appropriate to represent the number of 
learners enrolled in each grade level at a school and why?

16.	 Analyse a given bar chart showing the sales of different products and identify 
which products had the highest and the lowest. Explain how you reached 
your conclusion.

17.	 Discuss how a school can use visualisation to understand students’ 
performance. Recommend the types of charts to represent various aspects 
of the data and how the results can be interpreted to make data-driven 
recommendations.

18.	 What is the purpose of sorting data in a table?

19.	 List three different file formats in which you can save an Excel workbook.
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REVIEW QUESTIONS

20.	 What steps would you follow to print an entire workbook in Excel?

21.	 Explain the difference between sorting data in ascending order and descending 
order.

22.	 Explain applying a custom filter to display data within a specific date range.

23.	 Describe the process of sorting data in Excel by one column and then by a 
second column.

24.	 Explain the benefits of saving an Excel workbook to a cloud storage service 
versus saving it locally.

25.	 Given a dataset of students’ grades, explain how you would use sorting and 
filtering to identify the top 10 students in a class.

26.	 Analyse the impact of printing a large dataset without adjusting the print area 
and layout settings. What issues might arise, and how can they be mitigated?

27.	 Evaluate the effectiveness of using Excel sorting and filtering operations 
to manage an inventory system and discuss potential limitations whilst 
suggesting improvements.

28.	 Design an Excel template for managing customer orders for a shop. Include 
advanced sorting and filtering capabilities to analyse trends and performance 
metrics. Explain how these features can be used to make data-driven decisions.

29.	 How will you design a workflow for a team project where multiple team 
members must collaborate on an Excel workbook? Explain how you would 
manage the workbook’s saving, version control, and printing to ensure 
accuracy and consistency.
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ICTS IN THE SOCIETY
Emerging Technologies and Applications

INTRODUCTION

Imagine a world where everything works faster and more efficiently—thanks to 
technology! In this section, you will discover how technology will help you learn 
better in school using cool online tools and apps. You will also explore how doctors use 
technology to provide healthcare services remotely through telemedicine and manage 
health records easily. Ever wonder how factories produce goods so quickly? Machines 
and robots make it happen! Even government services are now easier to access, all 
thanks to technology.

But that is not all. You will learn how ICT (Information and Communication 
Technology) is transforming the way we bank, enjoy entertainment like movies and 
music, get around with apps like Uber, and shop online. Whether you are using tech for 
fun at home or running a small business, technology plays a role in making everyday 
life more convenient. Get ready to dive into how tech is changing the world around 
you!

KEY IDEAS

•	 Technology - This refers to tools, machines, systems, and devices that help us solve 
problems or make tasks easier

•	 Technology in Business: The use of technology in businesses to increase productivity 
and reach more customers

•	 Technology in Communication: The use of technology to communicate (exchange 
information) with people anywhere in the world

•	 Technology in Education: The use of technology in schools to improve teaching and 
learning.

•	 Technology in Healthcare: The use of technology to improved healthcare by allowing 
medical practitioners to diagnose and treat diseases more effectively

Activity 2.1 Technologies and their benefits

This activity will help you understand the positive impacts of technology in 
different areas. Your teacher will divide you into groups of not more than five for 
this activity.
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Instructions:

1.	 Name three technologies you use every day (like phones, computers, apps).

2.	 Using the internet, research on the impact of the technologies you named 
on education, health, and manufacturing in everyday life in conducting your 
research, think about questions such as:

a.	 How does technology make learning easier?

b.	 What are some tools used in hospitals?

c.	 How has technology changed how things are made?

4.	 Create a poster that lists the benefits you found from your research. Use 
simple words and colourful drawings or images to explain your ideas.

5.	 Present your poster to the class and explain one or two key benefits in your 
own words to the class.

TECHNOLOGIES AND THEIR BENEFITS TO 
VARIOUS SECTORS

Education and Technology
Technology enhances education by providing access to information, making learning 
interactive, fostering collaboration among learners and improving communication 
between teachers and learners. By embracing these technologies, learners can improve 
their learning experiences and outcomes.

Figure 2.1: Smart Classroom

Using digital tools like videos, pictures and quizzes can make learning more interesting. 
Platforms like Google Classroom help teachers share lessons, give assignments, and 
engage learners online.
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Benefits in using technology in education
1.	 Access to Information: Students can easily find information online, making it 

easier to research topics and learn at their own pace.

2.	 Interactive Learning: Tools like videos, games, and simulations make learning 
more engaging and fun, helping students understand difficult concepts better.

3.	 Collaboration: Technology allows students to work together from different 
locations. They can share ideas and projects using online platforms.

4.	 Personalised Learning: With technology, teachers can tailor lessons to meet 
the needs of each student, helping them learn in a way that suits them best.

5.	 Flexibility: Online classes and resources mean that learning can happen 
anytime and anywhere, making education more accessible.

6.	 Skill Development: Using technology helps students build important skills for 
the future, like problem-solving, critical thinking, and digital literacy.

7.	 Efficiency: Technology can help streamline tasks like grading and organising 
materials, giving teachers more time to focus on teaching.

Video – How AI Could Save (Not Destroy) Education | Sal Khan | TED

Healthcare and Technology
Technology in healthcare makes it easier for patients to receive care, helps doctors 
make informed decisions, and improves overall health services. Tools like smart 
beds and infusion pumps help track patient movements and administer medication. 
Telemedicine allows doctors to treat patients remotely and wearable devices track 
health data. Electronic Health Records store patient data online, making it easier to 
access and big data speeds up medical research and drug development.

Telemedicine: This is the use of digital technology to provide medical care and 
consultation remotely. It allows healthcare professionals to evaluate, diagnose, and treat 
patients without the need for in-person visits, often using tools like video conferencing, 
mobile health apps, and remote monitoring devices.

Figure 2.2: Smart Hospital Bed
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Benefits of Technology in Health
1.	 Improved Access to Care: Telemedicine and mobile health applications allow 

patients in remote or underserved areas to connect with healthcare providers, 
improving access to quality care.

2.	 Enhanced Patient Engagement: Digital health apps and wearable devices 
empower patients to monitor their own health metrics, helping them engage 
more actively in their wellness and treatment plans.

3.	 Efficient Record-Keeping and Data Management: Electronic Health Records 
(EHRs) streamline patient data, reducing errors, improving data accessibility for 
providers, and enhancing continuity of care.

4.	 Better Diagnostic Accuracy: AI-based tools assist in analysing medical imaging 
and diagnosing conditions more accurately and quickly, reducing human error 
and helping detect issues early.

5.	 Remote Patient Monitoring: IoT devices enable real-time monitoring of 
patients’ vital signs from their homes, allowing for proactive care and reducing 
hospital readmissions.

6.	 Cost Reduction: Automation, data management, and remote care reduce 
hospital costs and travel expenses, making healthcare more affordable for 
patients and providers.

7.	 Medical Research and Personalised Medicine: Big data analytics and AI 
allow researchers to analyse vast amounts of data, advancing personalised 
treatment plans based on individual genetics and health history.

Video - Hearing Aid feature for AirPods Pro 2 | Apple (https://www.youtube.com/
watch?v=dOuNLS1elWs)

Video - Man praises Apple Watch for life-saving alert after suffering medical emergency 
(https://www.youtube.com/watch?v=7TiDUvzE7IU)

Manufacturing and Technology
Technology plays a big role in making manufacturing better. It helps companies work 
efficiently, safely, faster, use fewer workers to create higher-quality products, etc. For 
example, Radio Frequency Identification (RFID) helps track products as they move 
through the factory, while the Internet of Things (IoT) connects machines so they can 
share information. 3D printing allows businesses to make parts quickly and accurately 
and blockchain technology helps manage the supply chain by keeping track of products 
at every step.

Understanding these technologies can give you insights into how products are made 
and how industries operate in Ghana and around the world.
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Figure 2.3: Robotic Manufacturing Arm

Video - They Turned off this GPU Factory For Me! PowerColor Factory Tour (https://www.youtube.
com/watch?v=GS35VHEfFDU)

Government and Technology
Information and Communication Technology (ICT) helps governmental bodies work 
better, be more accessible, and stay open with the public. Technology makes it easier 
for leaders to make decisions, create new policies, and manage government tasks 
efficiently. Example is the Parliamentary Watch App for monitoring activities of 
parliament of Ghana.

Figure 2.4: Parliamentary Watch App
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Table 2.1: Use of Technology in various sectors

Sector Use of Technology Examples

Education •	 Online learning platforms

•	 Interactive educational 
software

•	 Digital classrooms

•	 Google Classroom

•	 Khan Academy 

•	 E-books

Healthcare •	 Electronic health records

•	 Telemedicine

•	 Health monitoring devices

•	 Online doctor consultations

•	 Health apps for tracking 
fitness and diet

Manufacturing •	 Automation of production 
processes

•	 Use of robotics

•	 Inventory management 
systems

•	 Robots assembling products

•	 Use of software for tracking 
stock

Government •	 E-governance (online services 
for citizens)

•	 Data management systems

•	 Public information websites

•	 Online tax filing

•	 Government service portals 
(e.g., NIB, Passport Office)

Activity 2.2 Technology Application in various sectors

1.	 In groups of not more than five, pick one sector (education, health, 
manufacturing, governance) and research on how technology is applied in 
each case.

2.	 Create a presentation to be delivered to the whole class elaborating the 
benefits of technology on your chosen sector with evidence.

3.	 Deliver your presentation to the whole class. Allow other groups to ask 
questions and make contributions.

Activity 2.3 Problem- Solving

1.	 In groups of not more than five, identify at least 3 local problems in your 
community that you think technology can solve.
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2.	 Propose a technology-based solution, considering the resources available in 
your community, to solve the identified problem. Your proposal could touch 
on the following;

a.	 Automation: The use of technology to perform tasks with minimal 
human intervention, often used in manufacturing.

b.	 Telemedicine: The use of technology to provide healthcare services 
remotely, allowing patients to consult with doctors via video calls.

c.	 Digital Government: The use of digital technology by government 
agencies to improve services and engage with citizens

4.	 Present your proposed solution to the class for feedback and discussion.

Now, let us look at other fields that technology has become very impactful. In 
today’s world of technological advancement, you cannot talk about technology 
without mentioning areas such as: finance, entertainment, transport, and business

Finance
Technology in finance makes it easier for individuals and businesses to manage their 
money, make payments and invest. It provides convenience, saves time and allows 
more people to participate in the financial system.

Figure 2.5: Automated Teller Machine (ATM)

Entertainment Industry
Technology has transformed entertainment by making it more convenient and diverse. 
With just a few clicks, we can enjoy a variety of content and connect with others, 
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enhancing our overall entertainment experience. Video games now have advanced 
graphics, allow players to compete with others online and can be played on mobile 
phones.

Figure 2.6: technology in Entertainment

Activity 2.4 Benefits of technology in Finance and Entertainment

Complete Table 2.2 with the benefits of technology in finance and entertainment. 
Read the content of your table to peers for review.

Table 2.2: Benefits of technology in Finance and Entertainment

Field Importance of Technology integration

Finance

Entertainment

Sports
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Transport
Technology plays a significant role in improving transport systems in Ghana. It makes 
it more efficient, safer and easier for everyone. It helps people get to their destinations 
quickly and can reduce stress when traveling. Here are some ways technology is used in 
transport: Intelligent Transportation Systems (ITS), Autonomous Vehicles (Self-Driving 
Cars), Ride-Sharing Platforms etc.

Figure 2.7: Autonomous Vehicles (Self-Driving Cars)

Video - Cybercab | The Future is Autonomous

Benefits of Technology in Transportation
1.	 Increased Safety: Advanced driver-assistance systems (ADAS), like collision 

detection, lane-keeping assistance, and automatic emergency braking, help 
reduce accidents. Technologies like autonomous vehicles and vehicle-to-
everything (V2X) communication also contribute to safer roads.

2.	 Improved Efficiency and Reduced Congestion: GPS navigation, real-time 
traffic data, and smart traffic management systems help drivers avoid congested 
areas, reducing travel time and fuel consumption. Smart traffic lights also adjust 
in real-time to ease traffic flow.

3.	 Environmental Sustainability: Electric vehicles (EVs) and alternative fuel 
technologies reduce carbon emissions and pollution. Ride-sharing apps and 
vehicle-sharing systems encourage fewer vehicles on the road, contributing to a 
more sustainable environment.

4.	 Enhanced Passenger Convenience: Mobile apps for ride-hailing, ticket 
booking, and real-time tracking make commuting more convenient. Digital 
ticketing and contactless payment options streamline public transport use, 
improving the overall travel experience.
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Business
ICT (Information and Communication Technology) helps businesses create new 
products and improve their services. It helps businesses operate more efficiently, reach 
more customers, and improve communication. By so doing, businesses can grow and 
adapt to the changing market. For example, a company can use technology to design 
a new phone app that helps people manage their schedules better. It can also help in 
making production processes faster and more efficient. Many internet users advertise 
and sell their product remotely on their WhatsApp status, Facebook, etc. which does 
not require huge sum of money to secure a physical shop.

Figure 2.8: e-Commers for Business

Benefits of Technology in Business
1.	 Enhanced Transparency and Record-Keeping: Digital transactions create 

automatic records, making it easier to track, verify, and manage financial data, 
improving transparency and simplifying audits.

2.	 Global Reach and Accessibility: E-commerce platforms and digital currencies 
enable businesses to conduct transactions across borders seamlessly, expanding 
their customer base and making it easier for people around the world to access 
their products and services.

3.	 Cost Reduction and Scalability: Cloud computing, for instance, reduces the 
need for costly infrastructure, allowing businesses to scale up or down based 
on demand. E-commerce platforms also reduce operational costs and expand 
market reach by allowing businesses to sell online.

4.	 Increased Productivity and Efficiency: Automation tools and software 
streamline routine tasks, allowing employees to focus on higher-value activities. 
Project management tools, for instance, help teams organise tasks and meet 
deadlines efficiently.
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Activity 2.5 Matching activity

Table 2.3: Technologies and their uses in other sectors

S/N SECTOR TECHNOLOGY USE

1

Mobile Payment 
Systems

Online Banking

Financial Apps

2 Entertainment

Streaming Services

Gaming Consoles

Social media

3

Ride-Hailing Apps Services like Uber and Bolt that 
allow users to book rides using their 
smartphones.

Navigation Apps Applications like Google Maps that 
help users find directions and track 
routes.

Electronic Ticketing Systems that allow passengers to buy 
tickets for transport services online 
or through apps.

4 Business

E-Commerce 
Platforms

Office Productivity 
Tools

Video Conferencing

Activity 2.6 Personal Experience with Technology

Individually, share your personal experiences or observations on home users’ 
technologies to the whole class.
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Home Users
They are individuals and families who use technology every day for personal activities. 
They use computers and devices for tasks like communicating, having fun and being 
productive. Home users typically interact with technology in a non-professional way, 
meaning they are not using it for work-related purposes.

Figure 2.9: Smart Home

Activity 2.7 Research

1.	 In groups, each group focusing on one category of home technologies, 
research on the devices used by home users in your community, including 
their features and how they improve daily life.

2.	 Create a simple PowerPoint presentation (5 minutes) to share your findings. 
Include images of the devices and examples of how families use them.

3.	 Present your findings to the class, explaining the key technologies and their 
uses at home.

Small Home / Office (SOHO) Users
These are individuals or small business owners who work from a small office or home. 
These users rely on technology to help them work more efficiently and productively. 
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They use technology to manage their business tasks, communicate with others and stay 
organised. Unlike large businesses, they often have fewer resources and infrastructure, 
so they make the most of the tools they have.

Table 2.4: Technologies used by Home and Office

Technology Used by Home Users Used by Small Home /Office Users

Laptop/
Computer

•	 Browsing the 
internet, watching 
movies, schoolwork

•	 Sending personal 
emails, newsletters

•	 Managing business tasks, 
creating documents, 
communication

•	 Managing business 
communication with 
clients and suppliers

Smartphone •	 Social media, 
chatting, 
watching videos, 
entertainment

•	 Communicating with 
clients, sending emails, 
managing business apps

Wi-Fi/Internet 
Connection

•	 Streaming videos, 
browsing the web, 
playing online 
games

•	 Running business 
operations online, holding 
virtual meetings

Cloud Storage 
(e.g., Google 
Drive, Dropbox)

•	 Storing personal 
photos, videos, and 
documents

•	 Storing business files, 
sharing documents with 
clients

Smart TV •	 Watching Netflix, 
YouTube, or other 
streaming services

•	 Occasionally used for 
display boards around 
a business or meeting 
rooms.

Email Client 
(e.g., Gmail, 
Outlook)

•	 Sending personal 
emails, newsletters

•	 Managing business 
communication with 
clients and suppliers

Video 
Conferencing 
Software (e.g., 
Zoom, Microsoft 
Teams)

•	 Video chatting with 
family and friends

•	 Holding virtual meetings 
with clients or business 
partners

Office 
Productivity 
Tools (e.g., MS 
Word, Excel)

•	 Writing personal 
documents or 
school assignments

•	 Creating business reports, 
managing finances, and 
organising data
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Smart Devices 
(e.g., Smart 
Speakers, Smart 
Home Systems)

•	 Controlling home 
lighting, playing 
music, setting 
alarms

•	 (Not commonly used in 
small businesses)

E-Commerce 
Platforms (e.g., 
Jumia, Amazon)

•	 Shopping online for 
personal items

•	 Ordering office supplies, 
selling products online

Printer/Scanner •	 Printing school 
assignments or 
personal documents

•	 Printing business invoices, 
contracts, scanning 
documents

Activity 2.8 Technology used by small home/office

1.	 Each group will focus on a specific technology used by small/home office 
users.

2.	 Discuss how these technologies are useful for small business owners and 
home workers.

3.	 Each group should present a summary of their findings in a short 
presentation to the whole class.

Activity 2.9 Peer Learning and Role Play

1.	 Your teacher will assign you a role (e.g., a home user, a small business owner, 
a teacher working from home, etc.).

2.	 You will then be divided into pairs. In your pairs, you will share with your 
partner about the technologies your character would use and how they 
would use them (e.g., a home user may explain how they use a tablet for 
entertainment, while a small business owner might explain how they use a 
spreadsheet for managing business finances).

3.	 Role-play a scenario, explaining how you would use the technology in your 
daily tasks.

4.	 After role-playing, switch roles with your partner and repeat the activity. Try 
to be creative!
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Mobile Users
Mobile users are people who mostly use mobile devices like smartphones and laptops 
to access digital resources and services.

Power Users
Power users are people who have advanced skills and knowledge when it comes to 
using technology. These individuals can work with complex software, hardware, and 
computer systems.

Enterprise Users
Enterprise users are individuals who work in large organisations and companies. They 
use technology to help their businesses run smoothly, work together with colleagues, 
and manage important information.

Table 2.5: Technologies used by user groups

User Type Technologies Used Purpose/Use

Mobile Users •	 Smartphones

•	 Tablets

•	 Mobile Apps (WhatsApp, 
Facebook, Instagram)

•	 Mobile Payments (MTN

•	 Mobile Money, Vodafone Cash)

•	 Communication, social media, 
entertainment Accessing the 
internet, online shopping

•	 Mobile banking and payments

Power Users •	 Laptops/Desktops (High-
performance)

•	 Advanced Software (Photoshop, 
Video Editing Tools)

•	 Gaming Consoles

•	 Cloud Storage (Google Drive, 
Dropbox)

•	 Professional tasks (video 
editing, graphic design, 
programming)

•	 Managing large files, storing 
and sharing data online

•	 Gaming and multimedia 
creation

Enterprise 
Users

•	 Enterprise Software (ERP, CRM)

•	 Servers

•	 Cloud Platforms (AWS, 
Microsoft Azure)

•	 ideo Conferencing (Zoom, 
Microsoft Teams)

•	 Managing business operations 
(finance, customer relations, 
inventory)

•	 Hosting websites and storing 
large amounts of data

•	 Remote meetings and 
collaboration



74

YEAR 2 DIGITAL DEVICES, EXAMPLES AND IMPORTANCESECTION 2

Activity 2.10 Group Work

1.	 Your teacher will divide the class into three groups, each representing Mobile 
Users, Power Users, and Enterprise Users.

2.	 Make a simple chart on a piece of paper or a digital document. The chart 
should include:

a.	 User Group: Mobile, Power, Enterprise

b.	 Technologies Used: List at least three technologies for each group.

c.	 Benefits: Write one benefit of each technology.

d.	 Drawbacks: Write one drawback of each technology.

3.	 Present your chart to the class for further discussion.

Activity 2.11 Interactive Presentation

1.	 Chooses one user group (Mobile, Power, or Enterprise).

2.	 Prepares a 5-minute presentation that includes:

a.	 What the user group does

b.	 Examples of technologies they use

c.	 How these technologies help them

3.	 Presents your findings to the class. Allow questions for clarification about 
the presentation.

Activity 2.12 Group Discussion

1.	 In groups, discuss the following questions:

a.	 What new technologies do you think will be important for mobile users, 
power users, and enterprise users in the future?

b.	 How can these technologies make life easier for these users?

3.	 Each group shares their ideas with the class, focusing on one or two 
interesting points.
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EXTENDED READING
•	 Education and Technology: EdTech Impact and Innovations

•	 Healthcare and Technology: Healthcare Technology Innovations

•	 Manufacturing and Technology: Technology in Manufacturing

•	 Governance and Technology: e-Governance in Africa

•	 Financial Services/Banking and Technology: The Future of Banking: How Technology is 
Changing Financial Services

•	 Entertainment and Technology: The Evolution of Entertainment Technology

•	 Transport and Technology: How Technology is Changing Transportation

•	 Business and Technology: How Technology is Transforming Business

•	 www.khanacademy.org

•	 https://applieddigitalskills.withgoogle.com

•	 www.bbc.co.uk/bitesize

•	 www.gcflearnfree.org

•	 https://www.coursera.org/
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•	 https://cloud.google.com/gcp/?

•	 https://www.khanacademy.org/computing

•	 https://www.techopedia.com/
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REVIEW QUESTIONSREVIEW QUESTIONS

1.	 What are some examples of technology used in schools?

2.	 What are some medical devices that utilise technology to do their job 
effectively?

3.	 How can teachers use interactive whiteboards to enhance student learning?

4.	 Explain two ways that 3D printing technology be used to benefit businesses to 
create prototypes of new products?

5.	 What are the advantages and disadvantages of using online learning platforms 
for education?

6.	 Discuss how electronic health records can improve patient care coordination.

7.	 How can technology be used to personalise learning for learners with different 
needs?

8.	 What are some examples of technology used in financial services?

9.	 What devices are changing the way people enjoy entertainment?

10.	 How have mobile payment systems transformed the way that people pay for 
services?

11.	 Discuss the advantages and disadvantages of integrating finances with ICT.

12.	 How can technology be used to understand potential options within the 
finance industry for both an organisation and an individual?

13.	 Name three basic technologies used by most home users?

14.	 How can a small/home office user use video conferencing software to 
collaborate with clients remotely?

15.	 How are Small office and Home Users similar in relation to how they use 
devices?

16.	 You have been asked to advise a small business owner who operates from 
home and a family that wants to improve their use of technology at home.

17.	 Compare the technologies used by small/home office users and home users. 
Identify at least two devices or software that both groups use and explain how 
each group uses them differently.

18.	 Which of the following technologies is most commonly used by mobile users?

A.	 Cloud storage

B.	 Microsoft Excel

C.	 Network Servers

D.	 Smartphone Apps
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REVIEW QUESTIONS

19.	 Which of the following is most commonly used by enterprise users in 
businesses to manage large-scale operations?

A.	 Cloud storage services like Google Drive and Dropbox

B.	 Graphic design software like Adobe Photoshop

C.	 Social media apps like WhatsApp and Instagram

D.	 Word processing software like Microsoft Word

20.	 Explain the different types of technologies used by mobile users, power users, 
and enterprise users. Include examples of devices, software, and services used 
by each group, and how these technologies help them.
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ICTs IN THE SOCIETY
Connecting and Communicating Online

INTRODUCTION

Now that you have learned about emerging technologies in areas like education, 
healthcare, business, manufacturing and entertainment, it is time to dive into using 
the internet effectively. In this section, you will discover how to navigate the web 
using tools like web addresses (URLs), browsers, and mobile apps to access valuable 
information and resources easily.

You will also explore website features, learning to analyse and discuss elements like 
graphics, audio and video and understand how plug-ins make online experiences 
interactive and engaging. This knowledge will give you skills to effectively interact 
with multimedia content, helping you find and understand information in a fun and 
engaging way. By the end of this section, you will be more confident using the internet 
to connect, learn and even create your own engaging content.

KEY IDEAS

•	 Mobile Platforms: Mobile platforms are the platforms which allow internet access on 
smartphones and tablets.

•	 Navigation Menu: The set of links that help users move between different sections of 
a website

•	 Responsive Design: A website’s ability to automatically adjust its display based on 
different screen sizes

•	 Web Addresses (URLs): A web address, or URL, is a unique location for each webpage.
•	 Web Apps: Web applications (e.g., Google Docs, YouTube) are online programs 

accessible via browsers, offering tools for work, learning, and entertainment.
•	 Web Browsers: A web browser (like Chrome, Safari, or Firefox) is software that helps 

access and view websites.
•	 Website Layout: The arrangement and organization of content and navigation elements 

on a webpage
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Activity 3.1 Exploring with web browsers

1.	 Open any web browser on your computer.

2.	 Go to Google by typing “https://www.google.com” in the address bar and 
pressing Enter.

3.	 Type “how to use web browsers effectively” in the search bar and press Enter.

4.	 Look through the first page of search results, also called the “search hint” 
and choose a link that seems most relevant.

5.	 Once you have found useful information, save it by creating a bookmark 
(star icon).

6.	 Write a short summary of what you learned on a piece of paper or in a 
document.

7.	 Present your summary to the class for feedback and discussion

WEB ADDRESS
A web address, also called a URL (Uniform Resource Locator), is the unique address for 
a webpage on the internet, much like an address for a house or school. Every webpage 
has a specific URL that allows internet users to find and access webpages or online 
resource.

The Structure of a URL Includes Several Parts

Figure 3.1: Parts of URL

1.	 Protocol: The first part of the web address which sets rules for how data is sent 
securely.

2.	 Domain Name: This is the main part of the web address which identifies the 
website. Example, “ghana” in the above URL is the domain name.

3.	 Subdomain: It is found between the protocol and the domain name that shows 
a specific section of the website.
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a.	 .gov: A top-level domain (TLD), indicating that the site belongs to a 
government entity.

b.	 .gh: A country-code top-level domain (ccTLD), indicating that the site is 
based in Ghana.

Domain name extension: domain extension (also known as a top-level domain 
or TLD) is the part of a web address that appears after the last dot. URL endings, or 
domain extensions, like “.com,” “.org,” and “.edu,” indicate the type of website or 
organisation, such as commercial (.com), non-profit (.org), or educational (.edu). This 
URL system was introduced by Sir Tim Berners-Lee and the Internet Engineering Task 
Force in 1994, helping organise the internet, so users can easily find the resources they 
need.

4.	 Path and Parameters: The additional parts, which may specify a particular 
page or action on the site.

Activity 3.2 Constructing and decoding URLs

1.	 In a group not more than five (5), browse for a pdf file on the internet.

2.	 Copy the URL in the address bar into a word document window using your 
past experience on “Creating Word Document”

3.	 Reflect on the various parts of a complex website address which may include 
file names and file name extension.

4.	 Consider the URL you have copied which may be similar to the one below 
and name the various parts.

	 Example: https = protocol

5.	 Write the functions of the “File name” and the “file name extension” in the 
URL above.

6.	 Discuss as a class why specific URLs might use HTTPS instead of HTTP and 
why paths are structured in a particular way.
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Web Browser
A web browser is an application program used to surf the internet. Common examples 
include;

Figure 3.2: Examples of Web Browsers

Launching a Web Browser Using the Taskbar
1.	 Locate the browser icon on the taskbar.

2.	 Click on the icon to display the browser window as shown in Figure 3.3.

Figure 3.3: Parts of a web browser interface (Google Chrome)
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Common Features of a Web Browser
1.	 Title bar: It is located at the top part of the browser window which displays the 

browser and the webpage names.

2.	 Address bar: It is the main text-field where website addresses are typed. It also 
displays the Uniform Resource Locator when the browser window is displayed.

3.	 Navigation bar: The navigation bar is also called the standard toolbar. It contains 
tools such as the forward button, back button, and the refresh button which are 
used to browse through web pages. The image below shows the navigation bar.

4.	 Forward Button: It is used to visit a current webpage within active website.

5.	 Back Button: It is used to browse a previously visited webpage within active 
website.

6.	 Standard toolbar: it contains some basic tools like print icon, Copy, Home etc 
that are used most frequently in a given webpage.

7.	 Status bar: The status bar displays information and the state of a particular 
webpage.

8.	 Refresh Button/ Reload: It is a command button used to refresh a web page 
in a browser window. The Reload/Refresh button is used to fetch the latest page 
of a website.

9.	 Scrollbar: it is the electronic bar used to view a hidden portion of a webpage. 
There are two types of scrollbars. The vertical Scrollbar and the horizontal 
scrollbar.

10.	Stop Tab: It is used to terminate or cancel uploading page in a browser window.

11.	Bookmark: Saves a web page you like so you can quickly visit it later without 
searching for it again.

12.	History: Keeps a list of all the web pages you’ve visited recently, making it easy 
to find and revisit them.

13.	Extensions: It adds extra features to your browser, like ad blockers, password 
managers, or language translators.

14.	Developer Tools: Helps website creators test and fix their sites by showing the 
code, layout, and errors directly in the browser.

Activity 3.3 Differences and similarities in certain web browsers

1.	 Pair with one of your classmates

2.	 Use the skill gained in how to open a web browser and launch a different 
web browser each (Internet Explorer, Mozilla Firefox, Microsoft Edge, 
Safari, etc.); using different launching method such as double clicking on 
the browser icon, using the search bar, using the start button and its start 
menu, etc.
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3.	 In the table below, list the common and different features found in all the 
web browsers launched, including the interface in Figure 3.3.

4.	 In your pairs, use any web browser to search for any one public university 
in Ghana. Explore the programmes they offer and share your findings with 
the class.
Table 3.1: Features of web browser

Common features Non common feature

Uses of Web Browsers
1.	 Finding Information: Web browsers help users to search for information on any 

topic. When you open a web browser, it may display a search engine which can 
be used to locate information from the internet according to your search terms 
or key words.

2.	 Watching Videos and Listening to Music: You can watch videos on sites like 
YouTube and listen to music on platforms like Spotify using a web browser.

3.	 Connecting with Others: Browsers allow you to access social media sites like 
Facebook, Instagram, and Twitter, where you can communicate with friends 
and family.

4.	 Online Learning and Research: Web browsers are used to access online learning 
platforms, such as Google Classroom, where you can view notes, do assignments, 
and find extra learning resources.

Activity 3.4 Designing a mock website structure with URLs

1.	 In groups of not more than 4, design a mock website for a school. Each 
group will decide on sections for the website (e.g., “About Us,” “Admissions,” 
“Library”) and create an example of URLs for each section.

2.	 Each group present their website structure, explaining how they chose the 
domain name, paths, and any subdomains.

3.	 Each group discusses similarities and differences in their structures, 
exploring how URL structure impacts accessibility and user experience.
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Extension activity Exploring domain extensions and URL uses

1.	 In pairs choose a domain extension (e.g., .gov, .edu, .org, .com) to research 
what it signifies, including examples of reputable websites that use it.

2.	 Present your findings, explaining why certain types of organisations choose 
specific domain extensions.

3.	 Use the knowledge gained to discuss on how to assess the reliability of online 
information.

Accessing Web Apps
A web app, or web application, is a program that you can access and use directly 
through a web browser on any device with internet access, such as a laptop, tablet, or 
smartphone. Unlike traditional software, which you need to download and install, web 
apps work entirely online. Examples of popular web apps include Google Docs, Canva, 
Gmail, etc.

Figure 3.4: Web Apps

How to access a web app
1.	 Open Your Web Browser: Launch a browser like Google Chrome or Safari on 

your device.

2.	 Enter the Web Address: Type in the URL of the web app, or use a search engine 
to find it. For example, type “docs.google.com” for Google Docs.
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3.	 Log In or Sign Up: Many web apps require an account. If you are using one for 
the first time, you may need to sign up (meaning, to register). With an existing 
account, just log in with your username and password.

4.	 Use the Web App: Once logged in, you can begin working, whether it is typing a 
document, creating a design, or checking emails.

Table 3.2: Difference between Web apps and Traditional Apps

Feature Web Apps Traditional Desktop Applications

Access Accessed through a web 
browser with an internet 
connection.

Installed directly on a computer and 
run offline.

Installation No installation needed; can be 
used directly online.

Must be downloaded and installed on 
the computer.

Device 
Compatibility

Can be used on any device with 
a browser (e.g., laptop, tablet, 
smartphone).

Works only on the device where it is 
installed.

Updates Updates happen automatically 
online without user action.

Requires manual updates by the 
user or automatic updates when 
connected.

Storage Stores data online, which can be 
accessed from any device.

Data is stored on the local computer, 
limiting access to that specific device.

Activity 3.5 Accessing an educational Web App

1.	 In small groups, open a web browser and enter “khanacademy.org” in the 
address bar, then press Enter.

2.	 Create an account or sign in with an existing one

3.	 Navigate to a subject you are interested in, such as Math, Science or ICT.

4.	 Start a lesson by selecting a topic, watching videos, and practicing exercises.

5.	 Summarise the lesson that you researched and explain this to the rest of the 
class.

NAVIGATING MOBILE PLATFORMS
We will explore how mobile web browsers on smartphones and tablets work differently 
from browsers on computers. Mobile browsers are specially designed to make browsing 
easier on smaller screens that are controlled by touch.
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Some Unique Features of Mobile Browsers Include
1.	 Touch and Gesture Controls: For example, you can use the “Pinch-to-Zoom” 

gesture, which lets you zoom in and out on a web page by pinching your fingers 
together or apart on the screen.

2.	 Swipe Navigation: Instead of clicking buttons, you can swipe left or right to 
move back and forward through pages you’ve visited.

3.	 Adaptive Layouts: Websites on mobile browsers can automatically adjust their 
layout to fit the screen size and orientation, making the content easier to read 
and interact with. However, this is something that needs to be implemented by 
the website designer – on some websites this may not perform as expected.

Activity 3.6 Solving real-world scenarios on mobile browsing

1.	 In groups of not more than 4, choose one of the following scenarios that 
require using mobile browser features to find information.

2.	

a.	 Find a local news using a mobile browser and using “Pinch-to-Zoom” to 
focus on certain text

b.	 Explore how a popular website looks when they rotate the screen from 
portrait to landscape mode

c.	 Visit a site with multiple pages, then using swipe gestures to navigate 
back and forth between pages.

3.	 Each group will try the scenarios on their smartphones or tablets.

4.	 Observe and discuss how each feature (touch controls, swipe navigation, and 
adaptive layout) helps you browse more easily.

5.	 Share your findings with the class and discuss how these mobile features are 
useful in real-life browsing.

Features of Mobile web design and Apps
This simply talks about creating websites that work well on mobile devices like 
smartphones and tablets. They include the online stores, news sites, or blogs that look 
good on both phones and computers.

1.	 Mobile Web Design Principles: Websites are often designed to fit well on 
mobile screens, so you can view them clearly on your phone.

2.	 Responsive Web Design: This means websites adjust automatically to different 
screen sizes, like phones, tablets, and computers, so they look good on any device.
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3.	 Adaptive Layouts: Websites can change their design depending on how you 
hold your phone (portrait or landscape).

Mobile Apps
They are the Software specifically built to run on mobile devices, downloaded from 
app stores (e.g., Google Play or Apple App Store).

Mobile Apps: Many popular websites like Facebook, YouTube, and WhatsApp have 
mobile apps, which can be easier to use than their websites. When using mobile apps, 
it is important to think about how fast they load and how easy they are to navigate.

Key Features of Mobile Apps
1.	 Often works offline (depending on the app – many apps will open but require 

internet access to access features/data).

2.	 Can use device features like the camera, GPS, or notifications.

3.	 Customisable and highly optimised for mobile experience.

Figure 3.5: Mobile Apps

Table 3.3: Differences between mobile web design and mobile apps

Feature Mobile Web Design Mobile Apps

Access

Internet

Device Features

Updates

Through a browser Download from app store

Always needed Can work offline

Limited access Full access (e.g., GPS)

Immediate (no download) User must update manually
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Effective Web Navigation
Effective web navigation ensures how users can easily and intuitively (self-learning) 
find information or perform actions on a website. The key elements of effective web 
navigation include:

1.	 Clear and Simple Menus

2.	 Use concise labels (e.g., “Home,” “About Us,” “Contact”).

3.	 Keep menus minimal to avoid overwhelming users.

4.	 Consistent Navigation: Place menus, buttons, and links in the same location 
across all pages.

5.	 Search Functionality: It includes a search bar to help users quickly locate 
specific information.

6.	 Breadcrumbs: This display a path of links (e.g., Home > Products > 
Electronics) to show users where they are and allow easy backtracking.

7.	 Clickable Logos: Make the website’s logo clickable which can lead users back to 
the homepage.

8.	 Responsive Design: It ensures navigation works well on all devices, including 
smartphones, tablets, and desktops.

9.	 Highlight Current Location: Use visual indicators (e.g., bold text or a 
highlighted menu item) to show the user’s current page.

10.	 Call-to-Action (CTA) Buttons: Add prominent, well-labelled buttons for key 
actions (e.g., “Buy Now,” “Sign Up”).

11.	 Footer Navigation: Include secondary links in the footer for less prominent but 
useful sections (e.g., privacy policy, terms of service).

12.	 Fast Load Times: Optimise navigation elements to load quickly, preventing user 
frustration.

Using Search Engines to Find Information
Search engines like Google and Bing help you look out for information online. By 
typing in keywords, you can find resources, articles, and websites related to what you 
need.

Figure 3.6: Search Engine (Google)
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Using Advanced Search Techniques
1.	 Search Operators and Filters: There are special search parameters, like using 

quotation marks for exact phrases or adding “site:.gov” to find government sites. 
Filters like “Images” or “Videos” help you find specific types of content.

2.	 Refining Search Results: Using these techniques can make your search results 
more accurate, so you spend less time finding exactly what you need.

Evaluating Web Content for Credibility
1.	 Check for Reliable Sources: It’s important to confirm if the information on a 

website is trustworthy. Look for reputable sites, like official government pages 
or well-known news sites.

2.	 Fact-Checking Information: Do not believe everything you see online right 
away. Double-check information on multiple reliable websites to make sure it 
is accurate.

3.	 Author Information: Check if the author is identified and has relevant expertise 
or qualifications. Look for links to the author’s biography, credentials, or 
professional affiliations.

4.	 Sources and Citations: Look for properly cited sources and references to support 
claims. Avoid sites that provide opinions without evidence.

5.	 Updates and Maintenance: Ensure the content is up-to-date, especially for 
rapidly changing topics. Check for the “last updated” date if available.

WEBSITE
Website refers to the collection of related web pages stored in a web server. This means 
that when you visit the website of an institution, the pages that you may browse in the 
website must have similarities.

Website Features

Have you ever wondered how websites are organised to make them easy to use? Let us 
explore the basic parts of a website that you interact with every day!

What is a Website Layout?

Think of a website layout like the floor plan of a building, it shows where everything 
goes. Just like how a school has different areas (classrooms, library, assembly hall), a 
website also has different sections that helps you to find what you are looking for.
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Main Parts of a Website
Homepage

This is like the main entrance of a website. It is usually the first page you see when you 
visit a website. It tells you what the website is about and helps you to find other pages.

Example: When you visit https://www.gra.gov.gh/, the homepage shows you important 
news and links to other sections

Figure 3.7: Ghana Revenue Authority Homepage

Header

The header is like the signboard of a website. It usually contains the website’s logo, 
menu for navigation, search box, sometimes a phone number or contact information

Think of it like the top part of your exercise book where you write your name and 
subject.

Figure 3.8: Header of Ghana Revenue Authority (GRA) Website



93

YEAR 2 INTERNET EVOLUTION, ISPs AND THEIR FUNCTIONSSECTION 3

Navigation Menu

This is like a table of content that helps you move around the website. It shows the 
different sections you can visit example: hyperlinks to important pages, dropdown 
menus for more options.

Figure 3.9: Navigation Menu of Ghana Revenue Authority Website

Content Area

This is where the main information is displayed, example: text, pictures, videos and 
forms.

Figure 3.10: Content Area of Ghana Revenue Authority website

Sidebar

A sidebar is like a notice board on the side of the webpage that might show related 
links, recent posts, quick information, advertisements etc.

Figure 3.11: Sidebar of Bank of Ghana Website
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Footer

The footer is feature at the bottom of the website, like the last page of a book. It usually 
contains:

a.	 copyright information,

b.	 contact details,

c.	 links to social media,

d.	 additional navigation etc.

Activity 3.7 Website scavenger hunt

Materials Needed: Computer/phone with internet access - Activity worksheet

1.	 In pairs, visit http://www.ges.gov.gh

2.	 Find and list: 3 items in the header, 2 items in the navigation menu, 3 items 
in the footer and 2 items in the sidebar

3.	 Compare your findings with another pair

4.	 Discuss why each element is placed at where it is.

Figure 3.12: Footer of Graphic Online Website
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Website Responsiveness
Website responsiveness is a term that describes how a website automatically adjusts 
its layout, design, and features to look good and work well on any device, whether it’s 
a phone, tablet, or computer.

Figure 3.13: Website Responsiveness

Activity 3.8 Responsive design challenge

Materials Needed: 3 paper templates, Phone screen size, Tablet screen size, 
Computer screen size, Coloured markers.

1.	 Draw how the same website would look on:

a.	 A phone screen

b.	 A tablet screen

c.	 A computer screen

2.	 Show how the menu, content, and images would rearrange.

3.	 Present your designs to the class.

4.	 Explain why elements move/change on different screens.

Remember

•	 Every part of a website has a specific purpose

•	 Good websites are easy to navigate

•	 Websites should work well on all devices

•	 Different websites might arrange these features differently, but most will 
have these basic parts
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Activity 3.9 Design your dream school website

Materials Needed: Plain paper, Coloured markers/pens

1.	 In groups not more than 5, reflect on the layout of the “Homepage” of the 
“GES” website you visited and sketch a layout for your school’s website

2.	 Include and label:

a.	 Header with school logo and name

b.	 Navigation menu with at least 5 sections

c.	 Content area showing important school news

d.	 Sidebar with upcoming events

e.	 Footer with contact information

3.	 Present your design to the class and explain why you arranged the elements 
the way you did.

File format
A file format is a specific way information is stored electronically so that software can 
recognise and process it. Each file format has a unique structure, typically identified 
by its file extension (e.g., .docx, .jpg, .pdf). In this lesson, we shall concentrate on image 
file format types.

Image File Types
Have you ever taken a picture with your phone and noticed it saves as ‘.jpg’ or tried to 
create a school logo and seen ‘.png’ as an option? Let us learn about different types of 
images file formats we can use on computers and the internet.

Two Main Types of Image File Formats
Raster Images (Like a Mosaic)

Imagine creating a picture using tiny square tiles (like a mosaic). When you zoom in 
very close, you can see all the individual squares. This is exactly how raster images 
work.

What are Raster Images?

a.	 Made up of tiny squares called pixels (picture elements)

b.	 Like your phone’s camera pictures

c.	 Best for photographs and detailed images

d.	 Common in everyday use
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Table 3.4: Types of Raster Images

Format Description Best For Compression Transparency

JPEG A widely used 
format for photos 
and web graphics, 
balancing quality 
and file size.

Photos, web 
graphics

Lossy No

PNG Supports high-
quality images with 
transparency, often 
used for logos and 
graphics.

Logos, 
transparent 
images

Lossless Yes

GIF Used for simple 
animations or 
graphics with 
limited colours.

Animations, 
simple 
graphics

Lossless 
(limited)

Yes

BMP An uncompressed 
format storing raw 
image data; rarely 
used today.

Rare use, raw 
images

None No

TIFF A high-quality 
format commonly 
used in professional 
editing and 
printing.

High-quality 
prints, 
professional

Lossless Yes

SVG A vector-based 
format that scales 
without losing 
quality.

Scalable 
graphics

None Yes

WebP A modern format 
for web images, 
offering small file 
sizes and good 
quality.

Web images, 
fast loading

Lossy/Lossless Yes

RAW Captures all 
sensor data from 
cameras, ideal 
for professional 
photography.

Professional 
photo editing

None No
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Image compression
Lossy image compression reduces file size by permanently removing some image data, 
leading to a potential loss in quality, but achieving smaller file sizes. In contrast, lossless 
compression retains all original data, preserving image quality, but typically results in 
larger files compared to lossy methods.

Vector Images (Like a Math Drawing)
Think about drawing a circle in mathematics using a compass. No matter how big you 
make it, the circle stays smooth. This is how vector images work!

What are Vector Images?

a.	 Made using mathematical formulas

b.	 Can be made bigger or smaller without losing quality

c.	 Perfect for logos and simple designs

d.	 Like a mathematical drawing that stays sharp at any size

Table 3.5: Popular Vector Format

S/N VECTOR 
FORMAT

Best For Advantages Compatibility

1. SVG Web graphics, scalable 
designs

Scalable, 
lightweight

Supported 
by browsers, 
editors

2. AI Professional graphic 
design

Layers, 
advanced 
features

Adobe 
Illustrator only

3. EPS Printing, logos Versatile, 
platform-
independent

Most design 
software

4. PDF Document sharing with 
vectors

Easy sharing, 
retains quality

Universal 
compatibility

5. DXF CAD designs Interchangeable 
in CAD 
software

AutoCAD and 
similar tools

6. CDR CorelDRAW-specific 
designs

Complex, 
layered designs

CorelDRAW 
required

7. WMF/EMF Windows-based 
graphics

Office-friendly, 
editable

Windows tools
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Activity 3.10 Image format detective

Materials Needed: Mobile phone or computer, Worksheet

1.	 Look through your device’s gallery/photos

2.	 Find examples of:

a.	 Two JPEG images

b.	 Two PNG images

c.	 One GIF (if available)

3.	 Write down:

a.	 What type of content each image shows?

b.	 Why you think that format was used?

4.	 Share your findings with your class for discussion and feedback. .

Remember:

•	 JPEG: Best for photos

•	 PNG: Best for screenshots and logos

•	 GIF: Best for simple animations

•	 SVG: Best for logos that need to be resized

MULTIMEDIA
Multimedia refers to the combination of different types of media, such as text, 
images, audio, video, and animations, used together to create an engaging experience. 
It’s commonly used in websites, presentations, advertisements, entertainment, and 
education.

Have you ever wondered how websites play music, show videos, or create special 
effects? Let us explore how websites use different types of multimedia to make your 
online experience more interesting!

Integration of Audio and Video content to websites
Integrating audio and video content into websites enhances user experience, making 
them more interactive and engaging. It allows users to access rich media such as 
music, podcasts, tutorials, and product demonstrations. We shall now look at some key 
multimedia elements that can be integrated into a website.
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Audio on Websites
What is Website Audio?

Think of website audio like a radio built into a webpage. It can include:

a.	 Background music,

b.	 Voice recordings,

c.	 Sound effects,

d.	 Audio players for music or podcasts.

Common Uses of Audio
1.	 Educational Websites

a.	 Listening exercises

b.	 Pronunciation guides

c.	 Recorded lectures

d.	 Educational songs

2.	 Entertainment Websites

a.	 Music streaming

b.	 Online radio

c.	 Audio stories

d.	 Game sounds

Audio Controls
Just like your phone’s music player, website audio usually has: Play/Pause button, Volume 
control, Progress bar, Download option (sometimes).

Figure 3.14: Common uses of Audio
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Video on Websites
1.	 What is Website Video?

	 Videos on websites are like having a TV or film player right on the webpage. You 
see this on:

a.	 Video sharing sites. E.g. Vimeo, YouTube, etc.

b.	 News websites

c.	 Educational sites

d.	 Social media

2.	 Types of Website Videos

a.	 Embedded Videos

i.	 Videos hosted on YouTube or similar video sharing sites.

ii.	 Plays right on the webpage.

	 Example: A YouTube video on your school’s website.

b.	 Native Videos

i.	 Videos uploaded directly to the website.

ii.	 Usually shorter and optimised for web.

	 Example: Short clips on social media

3.	 Video Features

a.	 Modern web videos include:

i.	 Quality settings (like selecting 360p, 720p)

ii.	 Playback speed control

iii.	 Full screen option

iv.	 Captions or subtitles

Activity 3.11 Audio player investigation

Materials Needed: Computer/phone with internet access, Headphones (if 
available), Activity worksheet

1.	 In pairs, visit www.ghanaweb.com or any local news website

2.	 Find any audio elements (like radio streams or news clips)

3.	 List and draw:

a.	 Audio control buttons you find

b.	 Different audio features

c.	 How the audio player looks
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4.	 Try to:

a.	 Play and pause

b.	 Adjust volume

c.	 Move through the audio

5.	 In your pairs, discuss:

a.	 How easy was it to use?

b.	 What accessibility considerations were present on the website for the 
audio content?

c.	 What worked well?

d.	 What could be done better?

Activity 3.12 Create a video guide

Materials Needed: Paper, Coloured markers, Sample video player interface

1.	 In groups of not more than 5, imagine you are designing a video player for 
your school’s website

2.	 Draw and label:

a.	 Play/pause button

b.	 Volume control

c.	 Progress bar

d.	 Quality settings

e.	 Full screen button

3.	 Write simple instructions for:

a.	 How to play a video

b.	 How to adjust quality

c.	 How to use Full screen

4.	 Present your guide to the class

5.	 Explain why you included each feature

Plug-ins
What are Plug-ins?

Plug-ins are software components or add-ons that extend the functionality of an 
existing application or platform, such as a web browser, content management system, 
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or software tool. They are widely used to enhance user experiences and add new 
features without modifying the core application. Think of plug-ins as extra tools that 
add new features to your web browser. They are like adding new functions to your 
phone through apps.

Table 3.6: Common Types of Plug-ins and their uses

S/N PLUG-IN TYPE USES EXAMPLE

1. PDF Viewer For reading PDF documents online Reading your school’s 
newsletter

2. Media Players For playing special types of videos 
or music

Playing educational videos

3. Document 
Viewers

For viewing different types of files Opening Microsoft Word 
documents in your browser

Figure 3.15: Plug-In Types

Activity 3.13 Plug-in explorer

Materials Needed: Computer with internet access, Worksheet about common 
plug-ins

1.	 In groups of not more than 5, explore different types of plug-ins:

a.	 PDF viewers

b.	 Media players
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c.	 Document viewers

2.	 Make a list of:

a.	 What each plug-in does

b.	 When you might need it

c.	 Safety considerations

3.	 Create a simple guide for other learners

4.	 Present your finding
Table 3.7: Safety Tips When Using Multimedia

MULTIMEDIA AUDIO VIDEO PLUG-IN

SAFETY TIPS Keep volume 
at a safe level

Be careful 
with autoplay

Use 
headphones 
when needed

Watch videos 
from trusted 
sources

Be careful 
with 
streaming 
quality (data 
usage)

Check video 
descriptions 
before 
playing

Only 
install 
plug-ins 
from 
trusted 
sources

Keep 
plug-ins 
updated

Remove 
plug-ins 
you don’t 
use

Note

1.	 Not all websites need sound or video

2.	 Different devices might play multimedia differently

3.	 Good websites give you control over audio and video

4.	 Always think about your internet data usage when playing videos

5.	 Ask for help if a plug-in or media player is not working

Activity 3.14 Website media hunt

Materials Needed: Computer/phone with internet, Media hunt checklist

1.	 In pairs, visit three different Ghanaian websites

2.	 Find and document:

a.	 Audio elements

b.	 Video players

c.	 Different plug-ins
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3.	 For each one, note:

a.	 How it works

b.	 If it is easy to use

c.	 Any problems you find

4.	 Compare with other pairs.

Activity 3.14

1.	 Watch this video: How to Make YouTube Videos on Your Phone (Beginners 
Tutorial)

2.	 Splitting into small groups, take one of the following topics each:

	 Camera Angles

	 Lighting

	 Sound

	 Editing

	 Storytelling Techniques

3.	 Using what you learnt from the video, and other things that you have 
researched, or covering during the lessons, identify advice that you 
would give to someone who was recording videos. Create a PowerPoint to 
demonstrate this

4.	 Present your findings to the class as a group.
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EXTENDED READING
•	 https://www.digitallearn.org/

•	 https://www.edutopia.org/

•	 https://digitallearningedge.com/category/digital-literacy/

•	 https://digitallearningedge.com/category/technology-education/

•	 https://digitallearningedge.com/category/online-research/

•	 https://www.graphic.com.gh/

•	 https://mockingbird.marketing/responsive-websites-explanation/
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•	 www.w3schools.com

•	 www.khanacademy.org/computing

•	 https://developer.mozilla.org/en-US/docs/Learn

•	 www.figma.com

•	 www.canva.com

•	 www.bbc.co.uk/webwise

•	 www.soundcloud.com
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•	 www.ghana.gov.gh

•	 www.myjoyonline.com

•	 www.youtube.com

•	 www.ghanaweb.com
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REVIEW QUESTIONSREVIEW QUESTIONS

1.	 What is the main part of a URL that identifies a website called?

2.	 Who introduced the URL system in 1994?

3.	 What is the “Pinch-to-Zoom” gesture used for?

4.	 Name two popular search engines you can use to find information online.

5.	 List four main components of a website header.

6.	 What are the two main types of image file formats discussed in class?

7.	 Name three common image file formats and their extensions.

8.	 List three common controls found on a website’s video player.

9.	 Name two types of multimedia plug-ins commonly used on websites.

10.	 Explain why the “https” protocol is important in a URL

11.	 Why might a website use “.edu” as its domain extension?

12.	 Explain why a school website would use PNG format for its logo instead of 
JPEG.

13.	 Compare how a website’s navigation menu appears differently on a mobile 
phone versus a computer screen.

14.	 Describe how the footer of a website helps users, giving specific examples.

15.	 Explain how responsive web design helps make websites look good on 
different devices.

16.	 Why is it important to check for reliable sources when looking for information 
online?

17.	 Explain why a video might keep stopping and starting when you try to watch 
it online.

18.	 Describe what happens when you click the “mute” button on different types 
of audio players on a webpage.

19.	 Given this URL, “https://www.school.edu/registration,” identify the protocol, 
domain, and path.

20.	 A classmate wants to create a URL for a school sports page. What parts should 
they include in the URL structure?

21.	 You are searching for government policies on education. How would you 
refine your search to find only results from government websites?

22.	 You find conflicting information about a topic on two websites. How would 
you evaluate which one is more credible?
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REVIEW QUESTIONS

23.	 Your school needs photos from a recent event for both the website and for 
printing in large posters. Analyse which image format(s) would be best for 
each use and explain why.

24.	 Evaluate how a poorly designed website header might affect a user’s 
experience. Provide specific examples and solutions.

25.	 Your school wants to add educational videos to its website. analyse what 
factors they should consider before doing this.

26.	 Analyse how understanding the structure of a URL can help someone evaluate 
a website’s reliability

27.	 Design a step-by-step guide for your classmates on how to evaluate the 
credibility of a website when researching a school project. Include examples 
and explanations for each step.

28.	 Explain the elements that a multimedia policy for your school’s website must 
considers to meet all users’ needs.
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NETWORK SYSTEMS FOR TRANSMITTING 
INFORMATION
Guided and Unguided Network Systems

INTRODUCTION

Welcome to an exciting journey into the world of network systems.

Learning about these foundational networking topics is crucial for understanding 
how modern technology works and how it shapes our world. Networking enables 
the interconnection of computer-based devices to share information and resources, 
forming the backbone of communication in nearly every industry. Servers and 
clients illustrate the dynamic roles within a network, with servers providing services 
and clients requesting them. The design of a network, or its architecture, defines 
how devices interact and ensures efficient communication. Peer-to-peer networks 
and decentralisation highlight alternative models of resource sharing and control, 
empowering innovation without reliance on central authorities. Understanding 
communication protocols and scalability is essential for designing systems that can 
grow and adapt to increasing demands, which is critical in fields like technology, 
business, and digital infrastructure. These concepts are not just technical—they 
underpin how we connect, collaborate, and innovate in the modern world, making 
them valuable for any future career path.

You will now dive deep into how information travels between devices in Client/Server 
and Peer-to-Peer networks, as well as the difference between guided (wired) and 
unguided (wireless) communication systems. By the end of this section, you will:

1.	 Understand the various network systems and how they work.

2.	 Explore the communication technologies, protocols, and standards that power 
the internet and networks.

3.	 Gain practical knowledge to appreciate how these systems connect the world 
around us.

You will not only learn the theory but also get a chance to think critically, solve 
problems, and work in teams to solidify your knowledge. These life skills will empower 
you to better understand the networks you use every day.

Get ready to uncover the fascinating world of network communication—a skillset for 
today’s connected world.
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KEY IDEAS

•	 Architecture: The design and structure of a network, which defines how devices and 
components interact.

•	 Client: A hardware or software on a network that makes requests to a server.
•	 Communication: The exchange of data or information between devices within a 

network using protocols.
•	 Decentralisation: The distribution of network functions or control across multiple 

devices or nodes, without relying on a central authority.
•	 Network: Interconnection of computer-based devices to share information and 

resources.
•	 Peer-to-Peer Network: A decentralised network model where devices (peers) share 

resources and communicate directly without a central server.
•	 Scalability: The ability of a network or system to handle growth, such as adding more 

devices or increasing traffic, without performance degradation.
•	 Server: A hardware or software on a network that provide services to clients.

NETWORK
Computer network often simply referred to the collection of computers and 
computer-based devices interconnected by communication channels that facilitate 
communications and allow sharing of resources and information among interconnected 
devices.

Activity 4.1 Client and server

In order to recap on a previously covered topic, watch the following video:

Network Topologies - N10-008 CompTIA Network+ : 1.2

In small groups get together and answer the following questions

1.	 Explain what a network topology is.

2.	 Explain how does understanding network topologies contribute to effective 
network design and troubleshooting?

3.	 Identify one network topology that uses a server.

4.	 Explain your findings to the group.
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Architecture and Functionality of Client/
Server Network
The client-server model is a distributed framework where clients request resources or 
services, and servers provide them by the services requested. This model is designed for 
centralised resource management, scalability, and efficient handling of multiple client 
requests.

In networking, a client, such as a computer, smartphone, or software application, 
initiates a request for services from a server. The server, being a powerful central 
machine or program, processes these requests and provides the necessary services 
to the intended client. The Figure 4.1 below shows the architecture of Client/Server 
Network.

Figure 4.1: Sample of Client-Server Architecture

Table 4.1: Architecture of client/server network

Architecture of Client/Server Network

Server Client

1 A central machine or set of machines 
that provide services, resources, or 
data to clients.

Devices or programs that make requests to 
the server for services or resources.

2 Typically, powerful in terms of 
processing power, storage, and 
reliability.

Generally, less powerful than servers but 
optimised for user interaction and network 
communication.
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Table 4.2: Functionality of client/server network

Functionality of Client/Server Network

Client Server

1 A client initiates communication 
by sending a request to the server.

The server processes the request and sends back 
an appropriate response, such as data retrieval, 
resource access, or the execution of a command 
to the intended client

2 Clients rely on the server for 
access to shared resources, which 
makes management easier.

Servers manage resources centrally, allowing for 
better security, control, and updates.

Table 4.3: Layers of Client-Server Model

Presentation Layer Application Layer Data Layer

Purpose This layer is 
responsible for the 
user interface and 
interaction. It is the 
layer where users 
interact directly with 
the application.

This is the core of 
the architecture 
where the 
business logic is 
processed. It acts 
as an intermediary 
between the client 
and data layers.

The data layer is where 
the data is stored, 
managed and retrieved. 
It provides a mechanism 
for data storage.

Components Includes the software 
or applications that 
run on the client 
devices, such as web 
browsers, mobile 
apps, or desktop 
applications.

The application 
servers that process 
data, enforce 
business rules, and 
make decisions 
based on user input.

Databases, data storage 
systems, or data 
management tools.

Functionality Displays information 
to the user.

Sends user requests to 
the server.

Receives and formats 
data received from the 
server for display.

Processes client 
requests.

Applies business 
rules (e.g., 
processing a 
transaction, 
verifying login 
credentials).

Coordinates data 
retrieval or updates 
by interacting with 
the data layer.

Stores and manages data 
(e.g., user information, 
transactions, and 
product details).

Responds to requests 
from the application 
layer to retrieve, update, 
or delete data.
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How Client-Server Model Network Works
1.	 The computer-based devices, including the clients and the server must be 

connected to a network.

2.	 The client sends various requests to the server in order to submit, retrieve, 
or modify the data located on the server. For example, Client “A” with an IP 
address of 192.168.0.1 may send a request to the server to print a file with a 
printer connected on the network.

3.	 The server then processes each client request and provides services to the 
intended clients. From the example stated in point “2”, the server will provide 
services to the client by allowing the printer to print the intended file for the 
client.

The three basic layers to client-server architecture
Client-server architecture typically consists of three basic layers, known as the three-
tier architecture. These layers separate different functions of the application to improve 
scalability, manageability and flexibility.

Types of Client-server Architecture
1-Tier Architecture

1-Tier Architecture, also known as Single-Tier Architecture, is the simplest form of 
application architecture where all components of the application (presentation, 
application logic, and data management) reside in one place, usually on the same 
machine or device.

2-Tier Architecture

This consists of a direct communication link between the client and the server. The 
main components involved are the client which is the user interface or application 
that requests services or data; and the server that processes requests and provides the 
required services or data to the client. In this type of architecture, the client directly 
communicates with the server without an intermediary. This setup is straightforward 
and suitable for small-scale applications where the client sends a request, and the 
server processes it and returns the response.

3-tier architecture

In the 3-tier architecture, the client communicates with the application layer, which 
processes the request using business logic and interacts with the data layer if needed. 
The application layer returns the result to the client. For example, we use the user 
interface of a smartphone apps to interact with the app while an application server 
executes most of the app’s code and a database server stores the data.

From the above explanation, we could see that the application in 3-tier architecture is 
divided into three separate layers:
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1.	 Presentation Layer (Client): This is the front end where the user interacts on 
the network (e.g., web browser, mobile app).

2.	 Application Layer (business logic layer): It contains the business logic and also 
processes client requests (e.g., web server, application server).

3.	 Data Layer (Database Server): It manages data storage and retrieval of the 
network.

N-tier architecture

The N-tier architecture expands on the 3-tier architecture by adding more layers for 
better distribution of tasks and load balancing. The client communicates through 
multiple intermediary layers before reaching the data layer, which improves modularity 
and allows for specialised services. The additional layers may include,

1.	 Client Layer: User interface.

2.	 Web Server Layer: Handles HTTP requests and responses.

3.	 Application Server Layer: Processes the business logic.

4.	 Database Layer: Data storage and management.

5.	 Additional Layers: Security services, load balancers or caching layers.

Advantages

1.	 Centralised file storage makes it easier for multiple clients to share, store and 
operate on files.

2.	 Centralised databases improve data organisation, security and management.

3.	 Server scalability allows for easier hardware and performance management as 
well as cost savings.

4.	 Device management is more effective when done from a single server instead of 
individual clients.

Disadvantages

1.	 It is easier to infect a single server than individual clients.

2.	 Since centralised servers store the software and data, users lose all access if those 
servers fail.

3.	 Too many client requests can overload the server, causing performance issues 
and service outages.

4.	 Buying and running a server and networking equipment is an additional expense.

Peer-to-Peer (P2P) Networks
Peer-to-peer (P2P) network is a group of computers connected to each other directly 
whereby each of them acts as a node for sharing files within the group. Each computer 
acts as the server for the files instead of having a central server to act as a shared drive. 
This means the computers serving as the clients again serve as the servers since there 
is no central server.
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Figure 4.2: Peer to peer Network

From Figure 4.2, a peer-to-peer (P2P) network is a type of decentralised network 
where each participant (or “peer”) has equal privileges and responsibilities unlike the 
traditional client-server model. P2P networks do not rely on a central server, instead, 
each device in the network acts as both a client and a server, sharing resources directly 
with other peers.

Key Feature of Peer-to-Peer Network

1.	 Decentralisation: There is no central authority or server managing the network; 
each peer can initiate or complete tasks.

2.	 Resource Sharing: Peers share resources such as files, processing power, or 
bandwidth.

3.	 Direct Communication: Peers communicate directly with each other, without 
intermediate servers.

4.	 Dynamic Connectivity: Peers can join and leave the network as needed 
without affecting the overall network’s functionality.

5.	 Scalability: P2P networks can scale as more peers join since each additional 
peer adds more resources to the network.

Activity 4.2 Group discussion on network models

Having gone though both client-server network and peer to peer network models, 
make a deep reflection on the two network models in terms of connectivity, 
components, storage and functionalities.
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1.	 In groups of four to five, differentiate between the two types of network 
model according to the specification in the table below.

2.	 State the reasons why you will choose peer to peer network over client-server 
network.

3.	 Outline the challenges that may be associated with client-server computer 
network.
Table 4.4: Network models

SN. Specification Peer-to-Peer Network Client-server Network

1 Components

2 Network structure

3 Connection

4 Storage

5 Functionality

Advantages of Peer-to-Peer Network
1.	 Decentralisation: No central server which makes the connection easier as 

compared to Client-server network.

2.	 Cost-Effective: Reduces the need for expensive central servers.

3.	 Scalability: Easily expands as more peers join, adding resources and capacity.

4.	 Resource Sharing: All peers contribute resources, improving overall network 
efficiency.

5.	 Resilience: Continues functioning even if some peers go offline.

Disadvantages of Peer-to-Peer Network
1.	 Security Risks: Harder to manage and protect against malware or data breaches.

2.	 Inconsistent Performance: Network speed depends on the peers’ availability 
and resources.

3.	 Limited Control: Difficult to monitor and manage compared to a centralised 
network.

4.	 Data Duplication: Risk of multiple copies of data across peers, leading to 
inefficiency.
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5.	 Search Inefficiency: Locating specific resources can be slower in unstructured 
networks.

Table 4.5: Summary of the differences between Peer-to-peer network and client-server 
network

Aspect Peer-to-Peer Network Client-server Network

Structure Decentralised, no central server Centralised, with dedicated servers

Components All nodes act as both clients and 
servers

Distinct clients and servers

Storage Distributed across peers Centralised on servers

Mode of 
Connection

Direct connections between peers Clients connect to a central server

Scalability High, as each new peer adds 
resources

Limited by server capacity

Control Limited, hard to manage Centralised control and easier 
management

Reliability Resilient to single-node failures Dependent on server reliability

Security More challenging to secure Easier to secure due to centralised 
control

Performance Variable based on peers’ resources More consistent, server-dependent

Resource 
Sharing

Peers share resources directly Server provides resources to clients

Table 4.6: Summary of the similarities between Peer-to-peer network and client-server 
network

Aspect Peer-to-Peer Network Client-server Network

Purpose Facilitates data/resource sharing 
between devices

Facilitates data/resource sharing 
between devices

Connectivity Requires network connectivity for 
communication

Requires network connectivity for 
communication

Communication Support sending and receiving data Support sending and receiving data

Device 
Interaction

Devices communicate and share 
resources

Devices communicate and access 
resources

Network 
Protocols

Use common network protocols 
(e.g., TCP/IP)

Use common network protocols 
(e.g., TCP/IP)
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Activity 4.3 Configuration of peer-to-peer network

Working in small groups, discuss configuration of a peer-to-peer network 
involving four workstations.

1.	 List the materials that may be needed to configure or build the intended 
network.

2.	 State the two ways the workstations can be connected.

3.	 Demonstrate how you will connect the four workstations using “Ethernet 
cable” with RJ45 using end-to-end approach.

4.	 Discuss your approach with the entire class.

5.	 What additional resource(s) will you need when you want to configure the 
same four workstations on client-server network?

P2P NETWORK ARCHITECTURE
P2P (Peer-to-Peer) Network Architecture is a decentralised model where each 
participant, or “peer,” in the network acts as both a client and a server. Unlike traditional 
client-server architecture, there is no central server that manages resources or mediates 
interactions. Instead, each peer has equal responsibilities and capabilities, enabling 
direct communication and resource sharing between nodes.

In this network model, any node or computer in a Peer-to-Peer network can 
communicate with any other node, sharing files or data according to permissions.

Activity 4.4 Key features of P2P network

1.	 Pair with your colleague.

2.	 Review the following video - What is a P2P network I NordVPN

3.	 Reflect on how peer-to-peer network works and discuss the key features of 
it as spelt out in the table below.

4.	 Share your finding with another group.
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Types of P2P 
1.	 Pure P2P Network

In a pure P2P network, there is no central server or authority. Every peer is equal and 
has the same role in the network. Each peer acts as both a client and a server, sharing 
and requesting resources directly from others. Example: Early versions of Gnutella, 
where all nodes have equal responsibilities and there is no reliance on a central server 
for coordination.

2.	 Structured P2P Network

A structured P2P network uses a defined architecture and algorithms to organise and 
search for data efficiently. It usually uses technologies such as Distributed Hash 
Tables (DHT) to map data to specific peers, making searches more predictable and 
faster. Example: Kademlia and Chord, which use DHTs to organise peers and data.

3.	 Hybrid P2P Network

It is a combination of the P2P model and client-server model. While peers still share 
resources among themselves, a central server is used for specific functions such as 
indexing or connection management. The central server helps improve the efficiency 
of searching and coordinating peers, but the data is still shared directly between peers. 
Example: BitTorrent, which uses a central tracker server to help peers find each 
other, but the actual data transfer is peer-to-peer.

4.	 Unstructured P2P Network

In this type of network, peers are connected randomly without any predefined 
structure. Searching for data is less efficient because a search may require flooding 
the network with requests. However, it allows for more flexibility in terms of peer 
participation. Example: Early versions of Napster and Kazaa, where peers did not 
have a structured way of organising data or connections.

5.	 Permissioned P2P Network

It is a semi-private P2P network where peers must have authorisation to join. These 
networks often use cryptographic methods to ensure secure access and participation. It 
combines aspects of security and decentralisation, suitable for enterprise or specialised 
use cases. Example: Some blockchain networks like Hyperledger Fabric, where 
only authorized nodes can participate in data exchange.

Table 4.7: Types and key features of P2P network and their examples

Type of Network Key feature Example

Pure P2P Network Fully decentralised, no central server Early Gnutella

Hybrid P2P Network Central server for coordination, P2P 
data sharing

BitTorrent

Structured P2P Organised with algorithms for 
efficient search

Kademlia, Chord
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Unstructured P2P Random peer connections, flexible 
participation

Early Napster, Kazaa

Permissioned P2P Requires authorisation, secure access Hyperledger Fabric

Key Applications of P2P Networks
1.	 P2P removes the middleman between users, allowing for applications such as 

file-sharing, social networking, messaging and even financial transactions.

2.	 P2P networks are widely used for sharing large files directly between users 
without a central server. Examples: Early versions of Skype for voice and video 
calls.

3.	 P2P networks allow multiple computers to share their processing power to solve 
complex problems collaboratively.

4.	 P2P networks are used to distribute video and audio streams directly among 
users, reducing server dependency. Examples: PeerTube for video streaming and 
P2P live streaming platforms.

Activity 4.5 Key Features of P2P network

In small groups, complete the table below, you will then present your findings to 
the rest of the class.

Table 4.8: Activity on the key features of P2P network

SN. Specification How it works

1 Control or 
authority

2 Resource Sharing

3 Communication

4 Storage

5 Scalability
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BASICS OF ETHERNET TECHNOLOGY
Ethernet was invented by Robert Metcalfe, a researcher at Xerox PARC (Palo Alto 
Research Center) in 1973. He developed the idea as a way to connect multiple 
computers and devices within a local network to share data.

In 1976, Metcalfe, along with his team at Xerox, published a landmark paper titled 
“Ethernet: Distributed Packet-Switching for Local Computer Networks.” This paper laid 
the groundwork for Ethernet’s framework, using a coaxial cable and a method called 
Carrier Sense Multiple Access with Collision Detection (CSMA/CD) to manage data 
transmission and avoid packet collisions. The original Ethernet operated at a speed of 
2.94 Mbps

	 Figure 4.3: Coaxial cable 			   Figure 4.4: Twisted pair cable

Between 1980s-1990s, Ethernet technology moved from the original coaxial cables to 
twisted-pair cabling (e.g., Cat5, Cat6 cables) and fibre optics, improving flexibility and 
performance.

Over the years, Ethernet speeds improved 
significantly
1.	 10 Mbps in the 1980s (standard 10BASE-T)

2.	 100 Mbps (Fast Ethernet) in the 1990s

3.	 1 Gbps (Gigabit Ethernet) in the early 2000s

4.	 10 Gbps and beyond with advancements to 40 Gbps and 100 Gbps for specialised 
applications.

Activity 4.6 Ethernet Cabling

Video - https://www.youtube.com/watch?v=2oNq6Gtyf7M

1.	 Watch the above video and split into small groups

2.	 You will be allocated one of the ethernet cable types.
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3.	 Research the cable that you were allocated and identify speeds, length, 
advantages/disadvantages to that particular type of cable.

4.	 Create PowerPoint slide to present this information

5.	 Present this to the rest of the class.

Data Communication Models
Data communication models describe how data is transmitted between devices or 
systems over a communication medium. These models establish a framework that 
outlines the process and protocols for reliable communication. The two most widely 
known models are the OSI Model and the TCP/IP Model. Both of these models break 
down the communication process into layers to simplify the task of networking and 
ensure compatibility between devices.

Computer Network models
Computer Network Models is the structured frameworks that show how computers 
and devices communicate with each other across a network. These models define 
layers of operations, the protocols used in communication, and the services provided 
at each layer.

Types of Computer Network Models
There are two computer network models i.e. OSI Model and TCP/IP Model on which 
the whole data communication process relies

Figure 4.5: Types of Network

Communicating on a Network using the TCP/IP suite
Communicating over a network using the TCP/IP suite involves a structured 
framework that allows devices to send and receive data across interconnected networks, 
including the internet.

The TCP/IP (Transmission Control Protocol/Internet Protocol) suite operates in 
four main layers, each with distinct roles as show below;
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Figure 4.6: TCP/IP Network Model

1.	 Application Layer

This is the top layer where user interaction occurs. It provides services for applications 
to communicate over a network. The main function of the application layer is to prepare 
data for transmission by formatting it and adding necessary headers. Protocols like 
Hypertext Transfer Protocol for web browsing, File Transfer Protocol for file transfers 
and Simple Mail Transfer Protocol for emails are common examples of application 
layer.

2.	 Transport Layer

This layer is responsible for ensuring data transfer is reliable and error-free. TCP 
(Transmission Control Protocol) segments or UDP (User Datagram Protocol) are 
created here, adding a transport layer header to the data.

The main protocols of the transport layer are:

a.	 TCP (Transmission Control Protocol): A connection-oriented protocol that 
ensures reliable data transfer with error checking, acknowledgment of 
received packets and data retransmission if necessary.

b.	 UDP (User Datagram Protocol): A connectionless protocol that is faster 
but does not guarantee delivery, used for applications where speed is more 
critical than reliability (e.g., streaming, online gaming).

3.	 Internet Layer

This layer is responsible for logical addressing and routing of data across networks. 
In this layer, each device on the network has a unique IP address that identifies it 
and again routers forward packets based on IP addresses, ensuring data reaches its 
destination. The main protocol here is the Internet Protocol (IP), which defines IP 
addresses and helps route packets between the source and destination across different 
networks.
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4.	 Network Access/Link Layer

This layer handles physical data transfer between network devices, managing how data 
is placed on the network medium (e.g., cables, wireless signals). The data is broken into 
frames with link-layer headers and sent to the physical medium for transfer. In this 
layer, protocols like Ethernet or Wi-Fi determine how data frames are transmitted over 
physical networks.

Summary of the function of the TCP/IP Protocol
1.	 TCP (Transmission Control Protocol) ensures reliable, ordered data delivery and 

provides flow control, error detection, and correction.

2.	 IP (Internet Protocol): Responsible for addressing and routing packets to their 
destination. Defines IP addresses and packet structure.

3.	 The TCP/IP protocol is essential because it ensures end-to-end Communication 
between devices across different networks and interoperability of devices from 
different manufacturers. It is scalable and supports a large and growing number 
of devices on the Internet, and it is flexible.

The Open System Interconnection Model

The open systems interconnection (OSI) model is a conceptual model created by the 
International Organisation for Standardisation which enables diverse communication 
systems to communicate using standard protocols. The OSI model is a way of sub-
dividing a communications system into smaller parts called layers. The Open System 
Interconnection model is made in layers architecture, which allows easy data 
communication as each layer has predefined structured and functionalities.

Figure 4.7: TCP/IP Network Model

The Functions of the Layers

1.	 The Physical Layer: This is where the actual connection happens. It involves 
cables, switches, and signals that carry data from one device to another. Think 
of it as the roads for data to travel on.
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2.	 The Data Link Layer: This layer organises data into chunks called “frames” and 
checks for errors as data moves from one device to another. It is like a traffic 
controller making sure data goes where it is supposed to without collisions.

3.	  The Network Layer: The Network Layer is third from bottom in OSI model and 
is responsible for establishing data communication channel between multiple 
networks or devices or hosts or nodes. This layer finds the best path for data to 
travel between devices. It uses something like addresses called “IP addresses” to 
help data know where it is going, similar to how GPS helps find directions.

4.	 The Transport Layer: This layer breaks data into smaller parts (packets) and 
ensures they reach their destination correctly. It also checks if any packets are 
lost along the way and resends them. Imagine it as the postal service, making 
sure each letter arrives.

5.	 The Session Layer: This layer sets up, manages, and ends conversations or 
“sessions” between devices. It is like setting up a phone call and making sure 
both sides are ready to talk and hanging up when done.

6.	 The Presentation Layer: This layer changes data into a format that applications 
can understand (like converting languages). It also helps keep data safe through 
encryption. Imagine it as a translator or data protector.

7.	 The Application Layer: This is the layer that users interact with directly. It 
includes apps like web browsers, email, and games. Think of it as the place 
where we see and interact with the internet and other networked services.

The OSI Model is the most widely used computer network models which come with 
some major advantages which makes it so popular.

Advantages of OSI Models

1.	 Easy Troubleshooting: By dividing networking into layers, it makes it easier to 
pinpoint and fix problems in specific areas.

2.	 Promotes Compatibility: It helps different devices and systems work together, 
even if they come from different manufacturers.

3.	 Better Learning: The model helps students and professionals understand how 
networks work by breaking down complex tasks.

Disadvantages of OSI Model

1.	 Too Complicated: With seven layers, it can be overwhelming and unnecessary 
for smaller networks.

2.	 The model is mostly theoretical and does not always match real-world networks 
that follow simpler models like TCP/IP.

3.	 Can be Costly: Implementing a network to strictly follow the OSI Model can 
require extra equipment and software, raising costs.
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Activity 4.7 Importance of the OSI Model

Think pair share: Reflect on the OSI model and how each layer works.

1.	 Identify any three importances of this type of Network model.

2.	 Why do you think this network model is widely used?

3.	 As an ICT student, explain the benefits you will derive from learning about 
this type of network model.

4.	 In spite of the numerous advantages in OSI model, list any three setbacks 
associated with this network model.

HTTP and HTTPS Protocols
HTTP (Hypertext Transfer Protocol) and HTTPS (Hypertext Transfer Protocol Secure) 
are both protocols used for transferring data between a web server and a web browser. 
Let us take some few minutes to explore how each works.

Hypertext Transfer Protocol (HTTP)
HTTP is the foundation of data communication for the World Wide Web. It allows web 
browsers and servers to communicate and exchange information such as web pages, 
images, and other web content.

How It Works
HTTP works as a request-response protocol. The browser (client) sends a request to the 
server, which then responds with the requested data (e.g., an HTML page). One of the 
characteristic features of HTTP is that it does not encrypt the data being transmitted, 
making it vulnerable to interception and eavesdropping.

Hypertext Transfer Protocol Secure
HTTPS is an extension of HTTP and is used for secure communication over a computer 
network. It is essential for transmitting sensitive data like login credentials, payment 
information, and other private data. HTTPS provides an encrypted and secure 
connection, protecting data integrity and user privacy. HTTPS has security features 
such as:

1.	 Encryption: Prevents unauthorised access to the data being transmitted.

2.	 Authentication: Verifies the identity of the website, ensuring that users are 
communicating with the intended server.

3.	 Data Integrity: Ensures that the data is not altered during transmission.
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How It Works
HTTPS uses Secure Sockets Layer (SSL) or Transport Layer Security (TLS) protocols to 
encrypt the data between the client and server. This encryption ensures that even if the 
data is intercepted, it cannot be read without the proper decryption key.

Activity 4.8 Group work the differences between HTTP and HTTPS

1.	 Put yourselves into small groups.

2.	 Reflect on how HTTP and HTTPS work considering their purposes, port 
used, security and how they work.

3.	 You can also explore more information from the internet on the differences 
between HTTP and HTTPS.

4.	 Indicate the differences between HTTP and HTTPS in the table below based 
on the various key components specified in the table.
Table 4.9: Group work on the differences between HTTP and HTTPS

Features Hypertext Transfer Protocol Secure Hypertext Transfer Protocol

Purpose

Security

Port used

How it works

5.	 Explain your discussions to the rest of the class as a group.

SMTP OVERVIEW
SMTP (Simple Mail Transfer Protocol) is a standard protocol used for sending and 
relaying email messages over the internet. It is one of the essential protocols in the 
TCP/IP suite that supports email communication. The primary function of SMTP is to 
transfer outgoing emails from the sender’s email client to the mail server and from one 
server to another until it reaches the recipient’s mail server. SMTP is a push protocol, 
meaning it pushes email from the client to the server or between servers.

The Structure of the SMTP Message Format
The SMTP message format is structured to ensure that email communication follows a 
standardised protocol, facilitating consistent and reliable message delivery. An SMTP 
message consists of two main parts: the header and the body. But within these, there 
are other features in the structure as shown below.
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1.	 Envelope: Holds the basic information about who is sending the email and who 
will receive it.

2.	 Header: Includes important details like who the email is from, who it is going 
to, the subject, and the date it was sent. The header section contains crucial 
information that helps route and process the email correctly. Some key header 
fields include:

a.	 From: Specifies the sender’s email address.

b.	 To: Specifies the recipient’s email address.

c.	 Subject: A brief description of the content of the email.

d.	 Date: The date and time when the email was sent.

e.	 CC (Carbon Copy): Additional recipients who will receive a copy of the 
email.

f.	 BCC (Blind Carbon Copy): Recipients who will receive a copy of the email 
without being visible to other recipients.

g.	 Message-ID: A unique identifier for the email, often generated by the 
sending mail server.

h.	 Reply-To: Indicates where replies to the email should be directed, which can 
differ from the “From” address.

3.	 Body: This is the main part of the email that contains the actual message or 
content.

4.	 Command and Response Interaction: The email program and the server talk 
to each other using special commands and responses.

5.	 Commands: These are instructions like HELO/EHLO (saying hello), MAIL 
FROM (showing who the sender is), RCPT TO (showing who the recipient is), 
DATA (sending the message), and QUIT (ending the session).

6.	 Responses: The server replies to these commands with numbers and messages 
to show if things are working (e.g., 250 OK means all is good; 550 No such user 
means there is a problem with the recipient).

Activity 4.9 Think pair share on features of mail header

Having just spent time discussing Email headers, in small groups complete the 
following.

1.	 Reflect on how the common headers of a compose window work.

2.	 In the table below state the function of each of the headers as specified in 
the table.

3.	 Compare your finding in the table with your partner.
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Table 4.10: Think pair share on features of mail header

Key feature Function

To

CC

Bcc

Subject

How SMTP Works
1.	 Starting the Connection: The email program connects to the SMTP server to 

begin sending the message.

2.	 Introduction: The program introduces itself to the server by sending a “hello” 
message using commands called HELO or EHLO.

3.	 Sharing Details: The program tells the server who is sending the email (MAIL 
FROM) and who will receive it (RCPT TO).

4.	 Sending the Message: The program sends the actual content of the email (using 
the DATA command), which includes both the subject and the main message.

5.	 Closing the Connection: Finally, the program finishes by sending a command 
called QUIT, which ends the session and disconnects from the server.

FTP Overview
FTP (File Transfer Protocol) is a standard network protocol used for transferring 
files between a client and a server over a TCP/IP network, such as the internet. It 
is one of the oldest protocols designed for file sharing and still commonly used for 
uploading or downloading files from servers. Primarily, FTP allows users to transfer 
files (documents, images, programs, etc.) from one computer to another securely or 
publicly over a network.

Extension activity Collaborative project on files downloading and up-
loading

FTP is the commonly used protocol used to upload and download files unto and 
from the internet. Use the existing groups, perform the following tasks:

1.	 Differentiate the difference between downloading and uploading as used in 
internet environment.
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2.	 Demonstrate the appropriate steps to upload pictures to an internet platform 
such as Facebook or Instagram and also download an existing image from 
the same platform onto your computer.

3.	 Discuss where the downloaded files can be located on your computer.

4.	 Discuss what makes the uploading and downloading of the pictures possible.

How FTP works
1.	 Connection Establishment: FTP uses two separate connections:

a.	 Control Connection: Maintains the communication between the client and 
server for commands and responses.

b.	 Data Connection: Transfers the actual files between the client and server.

2.	 Ports Used:

a.	 Port 21 is used for the control connection (command and response exchange).

b.	 Port 20 is used for the data connection in active mode.

3.	 Modes:

a.	 Active Mode: The client opens a port and waits for the server to connect for 
data transfer.

b.	 Passive Mode FTP Passive Mode is an alternative to Active Mode that 
helps make file transfers more firewall friendly. This simply means that, it 
can operate smoothly without triggering security alarms or being stopped by 
the firewall.

FTP Commands and Responses
Common Commands:

1.	 USER: It specifies the username for authentication.

2.	 PASS: It specifies the password for authentication.

3.	 LIST: It lists the files and directories on the server.

4.	 RETR: It retrieves (downloads) a file from the server.

5.	 STOR: It uploads or sends a file to the server.

6.	 QUIT: This command ends the session and disconnects the client from the 
server.

7.	 Responses: FTP servers respond to commands with numeric codes and 
messages (e.g., 220 Service ready, 331 Username okay, need password, 550 
Requested actions not taken).
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Real-World Applications
1.	 Website Management: FTP is commonly used to upload files to a web server 

when managing websites.

2.	 File Sharing: Used in businesses and organisations to share large files that might 
be too large for email attachments.

3.	 Backups: Utilised for backing up data from one system to a remote server.

Limitations of FTP
1.	 Lack of Encryption: Basic FTP does not encrypt data, making it less secure for 

sensitive information.

2.	 Firewall Issues: FTP’s active mode can be blocked by firewall, which is why 
passive mode is often used to solve this problem.

3.	 User Authentication: Requires a username and password, but without 
encryption, these can be intercepted.

Wireless Communication Technologies
It is a communication technology which enables the transmission of data without 
physical connections, using electromagnetic waves. These technologies are foundational 
for mobile communications, internet access, and the connection of devices in various 
fields like IoT (Internet of Things) and smart homes. The most significant wireless 
communication technologies include:

1.	 Wi-Fi (Wireless Fidelity)

This allows devices to connect to the internet or a local network wirelessly. It uses radio 
waves, typically at 2.4 GHz, 5 GHz or even 6GHz frequencies, to create wireless local 
area networks (WLANs). It is mostly used in home and office internet access, public 
hotspots and device-to-device communication.

2.	 Bluetooth

It facilitates short-range data transfer between devices. It operates at the 2.4 GHz 
frequency band to connect devices like headphones, keyboards and smartphones over 
short distances (up to about 100 meters for newer versions). It is mostly used to connect 
wireless peripherals (headphones, mice), file sharing and connecting smart devices.

3.	 Cellular Network

It provides wide-area communication for mobile phones and devices. They are used in 
mobile phone services, data communication, and remote device connectivity.

4.	 NFC (Near Filed Communication)

This supports close-range data exchange between devices (a few centimetres apart). 
It uses magnetic field induction to enable communication between two NFC-enabled 
devices. It is often used in contactless payments, digital ticketing and sharing small 
amounts of data between devices.
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5.	 Infrared (IR) Communication

This transmits data using infrared light waves over short distances. It requires line-
of-sight between devices and has a limited range. This technology is used in remote 
controls, simple data transfers between close devices.

6.	 Satellite Communication

This transmits data over long distances using satellites in Earth’s orbit. It signals are 
sent from an Earth station to a satellite, which then relays the signal to another station 
or directly to user devices. The common devices which use satellite communication 
technology are GPS, satellite TV, satellite phones and global internet access in remote 
areas.

Table 4.11: Summary of wireless communication technologies

Technology/ 
Standard

Description Transmission 
Medium

Frequency Range Uses

Wi-Fi (IEEE 
802.11)

A family 
of wireless 
networking 
protocols

Ultra-high 
frequency 
(UHF) radio 
waves

2.4/5/6 
GHz.

100m 
(indoors), 
300m 
(outdoors)

Primarily used 
for local area 
networking 
(LAN) of devices

LTE (Long 
Term 
Evolution)

A standard 
for wireless 
broadband 
communica-
tion for mo-
bile devices.

Ultra-high 
frequency 
(UHF) radio 
wave

700-2600 
MHZ

Several 
kilometres 
depending 
on cell 
tower 
density

Mobile internet, 
VoLTE (Voice 
over LTE) 
application

Bluetooth Short-range 
wireless 
technology 
standard for 
exchanging 
data over 
short 
distance.

ultra-high 
frequency 
(UHF) radio 
wave

2.4 GHz Typically, 
up to 10 
metres 
(Class 2), 
up to 100 
metres 
(Class 1)

Used to connect 
peripheral 
devices (e.g. 
keyboards, 
mice), audio 
devices or file 
transfer. Can 
also be used to 
share internet 
between 
different devices.

IrDA 
(Infrared 
Data 
Association)

A standard 
for wireless 
communi-
cation using 
infrared light

Infrared light 850 nm to 
900 nm 
Spectrum.

Up to 1 
metre

Remote controls 
and short-range 
data transfer 
between devices. 
This is very 
rarely used due 
to low speed 
and line of sight 
requirement.
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RFID (Radio 
Frequency 
Identifica-
tion)

A technolo-
gy that uses 
electromag-
netic fields to 
automatically 
identify and 
track tags 
attached to 
objects

Radio Low 
frequency 
of (125134 
kHz), high 
frequency 
(13.56 
MHz) or 
ultrahigh 
frequency 
(860960 
MHz)

Passive 
tags have 
a range 
of several 
metres 
whilst 
active tags 
have tens 
of metres

Inventory 
tracking, access 
control, and 
contactless 
payments

NFC (Near 
Field Com-
munication)

A set of com-
munication 
protocols for 
communica-
tion between 
two electron-
ic devices 
over a short 
distance

Electromagnet-
ic induction

13.56 MHz up to 10 
cm

Contactless 
payments (in 
EPOS systems), 
access control, 
data exchange 
between devices.

Satellite 
Internet

Satellite inter-
net is a wire-
less internet 
service that 
uses satellite 
communica-
tion to deliver 
broadband 
speeds to 
remote areas. 
Data is sent 
to and from 
satellites 
orbiting the 
Earth.

Satellite signals Ku-band 
(12–18 
GHz), 
Kaband 
(26.5– 40 
GHz), 
C-band (4– 
8 GHz)

Global 
(thousands 
of kilome-
tres)

Remote 
areas, rural 
connectivity, 
emergency 
services, 
maritime and 
aeronautical 
internet access

Activity 4.10 Collaborative project on protocols/standards and their ad-
vantages and limitation

1.	 Organise yourselves into small groups. Each group will be allocated one of 
the protocols covered in the lesson

2.	 Research the protocol using the following guiding prompts:

a.	 When was it created and who created it?

b.	 What is it used for?

c.	 Advantages and limitations in using it
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d.	 Any other interesting facts

3.	 Create a PowerPoint and present this to the rest of the class for feedback and 
discussion.

EXTENDED READING
•	 Client-server network model and P2P NETWORK: BSCIT_402_slm.pdf page 5-22

•	 P2P Network: p2p-mie.ppt pages 2-9
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REVIEW QUESTIONSREVIEW QUESTIONS

1.	 What is a network, and what is its primary function?

2.	 What are the two main types of network architectures?

3.	  What is the basic role of a client in a network?

4.	 Define “protocol” in the context of network communication.

5.	 Identify the key difference between a client and a server in a Client/Server 
network.

6.	 Give an example of a common application that uses a Client/Server network 
model.

7.	 Identify the protocol used by web browsers to traverse the World Wide Web.

8.	 Explain the purpose of the DNS (Domain Name System) in internet 
communication.

9.	 Explain the difference between HTTP and HTTPS.

10.	 What is the role of the Presentation Layer in the OSI model?

11.	 Explain why a Client/Server network might be a better choice for a large 
organisation with many users compared to a Peer-to-Peer network.

12.	 Discuss the advantages and disadvantages of using a Peer-to-Peer network for 
sharing files among a small group of friends.

13.	 Analyse the benefits and challenges of using RFID technology for tracking 
inventory.

14.	 Discuss how the OSI and the TCP/IP Model relate to each other.

15.	 What are the benefits to using ethernet to allow devices to communicate?

16.	 Discuss the role of Wi-Fi and LTE protocols in providing wireless internet 
access. (WiFi - local area network, LTE - cellular network).

17.	 Imagine you are setting up a home network. Explain how different protocols 
(e.g., Wi-Fi, TCP/IP) work together to allow your devices to connect to the 
internet and access online resources.

18.	 Discuss the emerging trends in network communication protocols, such 
as the development of faster and more secure protocols for the Internet of 
Things (IoT) and 5G networks. How can these advancements impact our 
future communication methods?

19.	 Discuss how advancements in satellite communication could bridge the 
digital divide in remote areas.
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NETWORK SYSTEMS FOR TRANSMITTING 
INFORMATION
Computer and Information Security

INTRODUCTION

This section is a continuation of year one lessons that introduced you to network 
systems for transmitting information. Here, you will learn and understand safety and 
security issues in the use of ICTs. The section is designed to help you understand and 
evaluate the risks associated with using ICTs which includes internet and network 
attacks such as cyberbullying, malware, botnets, denial-of-service attacks, spoofing, 
hardware theft and firewalls among others. You will also discuss the preventive 
mechanisms such as antivirus software, hardware and software firewalls to mitigate 
computer network and security risks.

KEY IDEAS

•	 Computer Network Security refers to the practice of protecting computer networks 
from unauthorised access, attacks, or damage. It involves a variety of technologies, 
policies, and procedures designed to safeguard the integrity, confidentiality, and 
availability of data and services on a network.

•	 Computer Security has to do with protecting the hardware such computers and servers 
and software like operating systems and applications from threats such as hackers or 
viruses.

•	 Information Security focuses on safeguarding the actual data itself. Whether it is 
personal information, financial data, or business secrets, ensuring that only authorised 
people can access it and that it remains private and accurate.

•	 Network Security Risks are the potential threats or vulnerabilities that can compromise 
the security of a network.

CYBERBULLYING
Cyberbullying is when someone uses the internet, social media, or other digital 
platforms to hurt, threaten, or embarrass another person. It can involve sending 
offensive messages, posting hurtful comments, spreading rumours, or sharing 
private information to make the victim feel bad or scared. Unlike bullying in person, 
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cyberbullying can happen at any time and reach the victim anywhere, even in the 
safety of their own home. It’s a harmful behaviour that can have serious effects on the 
person’s mental and emotional well-being.

Table 5.1: Forms of Cyberbullying

S/N FORM EXPLANATION

1 Doxing Posting someone’s private information (like their home 
address or phone number) online to harm them or make 
them feel unsafe.

2 Cyberstalking Repeatedly sending threatening or abusive messages, or 
following someone online in a way that makes them feel 
unsafe or scared.

3 Trolling Posting offensive or provocative comments online just to 
upset or annoy someone, often in comment sections or 
forums.

4 Impersonation Pretending to be someone else online and saying or doing 
things that can harm the person being impersonated, like 
sending fake messages or posting embarrassing content.

5 Outing Sharing someone’s private information or personal photos 
online without their permission to embarrass or hurt them.

6 Harassing 
Messages

Sending hurtful, threatening, or mean messages through 
texts, emails, or social media.

7 Exclusion Intentionally leaving someone out of group chats, social 
media activities, or online games to make them feel 
unwanted or isolated.

8 Spreading 
Rumours

Sharing false or private information about someone online to 
make others believe something bad about them.

Figure 5.1: Some common effects of cyberbullying
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Activity 5.1 Matching activity on effects of Cyberbullying

This activity will help you understand the effects of cyberbullying on people. 
In this activity, you are to write one word that best suits the image and the 
corresponding description. You can use Figure 5.1 as a guide.

Table 5.2: Some effects of Cyberbullying

Image Description One word that matches 
image and description

When you feel alone or separated 
from others. It is like being in a 
place where no one else is around, 
and you don’t feel connected to 
anyone. You might feel lonely, as if 
you are left out or not included in 
things

A strong feeling of frustration or 
upset. You might feel it when things 
are not going your way, or when 
someone hurts or disrespects you. It 
is like an emotional fire inside you 
that can make you want to shout, 
argue, or even do something to get 
back at the person or situation that 
made you angry.

a feeling of deep sadness or 
hopelessness that lasts for a long 
time. It’s not just feeling sad for 
a day; it can make you feel like 
you don’t enjoy anything, have no 
energy, or that things will never get 
better. It can affect how you think, 
feel, and act.

When you feel very embarrassed 
or ashamed, especially in front of 
others. It is like being made to feel 
small or worthless, often because 
of something that happened or 
something someone said. It can 
make you feel like everyone is 
judging you.

When someone’s body or health is 
affected from feeling embarrassed, 
sad, upset or frustrated for being 
bullied online. This can make a 
person feel unwell.
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Preventing Cyber Bullying
Preventing cyberbullying means taking steps to stop people from bullying others 
online. Figure 5.2 shows some common ways of preventing bullying online

Figure 5.2: Ways of preventing Cyberbullying

Activity 5.2 Creating a flyer on Preventing Cyberbullying

1.	 Pick three of the preventive measures of cyberbullying listed in Figure 5.2 
and produce a flyer manually or digitally to educate computer uses on how 
to stay safe on the internet.

2.	 Your flyer should have explanations to your chosen preventive measures.

MALWARE
Malware (malicious software) is any type of computer program designed to harm or 
disrupt a computer, network, or device. It can steal your information, damage your 
files, slow down your system, or even give someone else control over your device 
without your permission.

Types of Malwares
There are many types of malwares, each with specific functions and purposes.
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Table 5.3: Types of Malwares

S/N TYPE DESCRIPTION

1 They are types of malwares that often take the form of a 
piece of code inserted in an application, program, or system 
and they are deployed by victims themselves. They can seize 
applications, send infected files to contact lists and also steal 
data.

2 A worm spreads itself from one computer to another without 
needing any help from people. It can travel through the 
internet, email, or other networks automatically, infecting new 
systems as it goes. The main problem with worms is that they 
can spread very quickly, causing damage by slowing down 
systems, stealing information, or even crashing networks.

3 This type of malware tricks users into thinking it is something 
safe or useful. Once it is inside a computer, it can cause a lot 
of damage such as stealing your personal information (like 
password), give hackers access to your computer and damage 
files or make your system to slow down.

Unlike worms or viruses, Trojans don’t spread by themselves.

4 Spyware is designed to secretly monitor and collect a user’s 
activities without their knowledge, often to steal sensitive 
information like passwords, credit card numbers, or personal 
data.

5 Adware is software that automatically delivers unwanted 
advertisements. While often not malicious by nature, some 
adware can track user behaviour and interfere with the 
system’s performance.

How malware spread
1.	 USB Drives/Removal Drives: If you plug an infected USB drive into your 

computer, the malware can transfer from the drive to your system. This can 
happen without you realising it.

2.	 Email attachments: Malware often hides in attachments to emails that look 
like legitimate messages. When you open the attachment, the malware infects 
your computer.

3.	 Social media and Links: Malware can spread through fake links or posts on 
social media. If you click on these links, you might be tricked into downloading 
malware or visiting a harmful website.

4.	 Infected Websites: Some websites contain hidden malware that can 
automatically download to your computer when you visit them. This can happen 
even if you do not click anything.
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5.	 Fake Software Downloads: Malware can disguise itself as free software, games, 
or updates. When you download and install it, you are actually getting malware 
instead of the program you thought off.

Prevention and protection from Malwares
1.	 Avoid Downloading from Untrusted Sites: Only download software from 

trusted websites, and be cautious of free programs or games, as they may carry 
malware.

2.	 Use Antivirus Software: Install and regularly update antivirus software. It 
helps detect and block malware before it can cause damage.

3.	 Be Careful with Emails and Attachments: Don’t open email attachments or 
click on links from unknown or suspicious senders. Scan email files with anti-
virus before you open its content.

4.	 Keep Software Updated: Make sure your operating system, web browser, and 
apps are up-to-date. Updates often include security patches that fix vulnerabilities 
that malware could exploit.

5.	 Use Strong Passwords: Use strong, unique passwords for your accounts and 
enable two-factor authentication (2FA) when available. This can help protect 
your personal information from being stolen by malware.

6.	 Disconnect from Untrusted Networks: Avoid using public Wi-Fi for sensitive 
activities (like online banking) because it’s easier for malware to spread over 
unsecured networks. Use a VPN if you need to connect to public Wi-Fi.

Activity 5.3 Research Activity on Malware

In groups of no more than five, pick one type of malware that you have learned 
so far.

Research on the following:

1.	 It’s history

2.	 How it spreads

3.	 Include recent examples of attacks and dangers that it brings to computer 
users

4.	 How to prevent that particular malware

In your groups, create a presentation with your findings together and present to 
the whole class for discussion and feedback
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BOTNETS
Botnets are groups of infected devices, often called zombies or bots. These devices can 
be anything like computers, phones, or even smart appliances. Botnets are one of the 
most common and serious types of malwares. They work together without the owner’s 
knowledge to do things for the hacker. For example, a hacker might use a botnet to:

1.	 Flood a website with traffic to make it crash.

2.	 Steal personal information like passwords or bank details.

3.	 Send spam emails to infect even more devices.

The main danger of botnets is that they can control many devices at once, making 
them very powerful for cybercriminals.

Figure 5.3: Botnet

Denial-of-service attacks
A Denial-of-service (DoS) attack is when a hacker tries to make a website or online 
service stop working by overpowering it with too many requests or traffic. The goal is 
to make the service unavailable to its users

Imagine a website like a classroom with a limited number of seats. If too many people 
try to sit in that classroom at the same time, the classroom gets crowded and real 
members of the class cannot get a seat to sit on. In the same way, during a DoS attack, 
the target system gets so much traffic that it crashes or slows down and legitimate users 
cannot access the website or service.
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Figure 5.4: Denial-of-service attack (DoS)

Characteristics of a denial-of-service attack (DoS)
1.	 Overloads the Server: A DoS attack floods a website or server with so much 

traffic that it becomes overwhelmed and can’t handle normal requests. This 
causes the server to slow down or crash.

2.	 Targets a Single System: In a typical DoS attack, all the traffic comes from one 
source (a single computer or device) controlled by the attacker.

3.	 Makes the Website Unavailable: The main goal of a DoS attack is to make 
a website or online service temporarily unavailable, meaning legitimate users 
can’t access it.

4.	 No Data Theft: Unlike other types of attacks, a DoS attack doesn’t usually steal 
information. Its main purpose is to disrupt access to the site, not to compromise 
personal data.

5.	 Temporary Impact: While a DoS attack can cause serious disruptions, it usually 
doesn’t cause permanent damage. The website or service can often be restored 
once the attack stops.

Types of Denial-of-service Attack

Figure 5.5: Types of Denial-of-service attack
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Protection against denial-of-service (DoS) attacks
1.	 Pre-emptive measures: These measures help prepare your system to handle 

potential DoS attacks before they happen, making it more resilient and reducing 
the chances of an attack succeeding.

2.	 Post-attack response refers to the actions you take after a DoS attack has 
happened to minimise damage, fix the issues, and prevent future attacks.

Table 5.4: Pre-emptive Measure and Post-Attack Response on DoS

Pre-emptive Measure Post-Attack Response

Set Up Web Application Firewalls (WAF) 
that filters and monitors incoming traffic to 
your website, blocking suspicious requests 
that may come from a DoS attack.

Identify the Attack: The first step is to 
understand what happened. You need to 
check your logs, network traffic, and systems 
to see how the attack occurred and which 
parts of your system were affected.

Implement Rate Limiting to controls how 
many requests a user or device can make to 
your server in a certain period of time. This 
helps prevent attackers from flooding your 
system with too many requests at once.

Block the Attack Source: If possible, find 
the attacker’s IP address or source of the 
attack and block it from accessing your 
network or website

Have multiple servers, networks, or data 
centres in different locations. By spreading 
the load, it becomes harder for a DoS attack 
to bring down all systems simultaneously, 
ensuring your service remains available.

Restore Services: Once the attack has 
been stopped, work on getting your website 
or service back up and running. This may 
involve rebooting servers, restarting services, 
or removing harmful data that was affected.

Use a Content Delivery Network 
(CDN): this feature distributes your 
website’s content across multiple servers 
around the world, so even if one server gets 
overloaded, others can handle the traffic to 
make it much harder for attackers to target 
a single server.

Evaluate the Damage: Check if there was 
any data loss, security breaches, or other 
harm done during the attack. Make sure your 
systems are clean and secure before allowing 
normal operations.

Set up real-time monitoring to track 
incoming traffic patterns. Early detection 
of unusual spikes in traffic can help you 
identify and stop a potential DoS attack 
before it causes major damage.

Improve Defences: After the attack, 
analyse what went wrong and strengthen 
your security measures. This could involve 
adding firewalls, increasing server capacity, 
or improving your traffic filtering to be ready 
for future attacks.

Effects of DoS Attacks
When someone tries to stop a website or online service from working by overwhelming 
it with too many requests at once, it results in some negative impacts on the individual 
users and the organisations
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Figure 5.6: Effects of DoS Attacks

Distributed denial of service (DDoS) attack
A distributed denial of service (DDoS) attack is when many computers or devices team 
up to overload a website or online service, making it slow or even crash. Think of a 
website as a small shop with one door. If thousands of people rush in at once, the shop 
can’t serve its usual customers, and everyone gets stuck outside.

In a DDoS attack, the traffic comes from many computers or devices, often without the 
owners knowing. These devices are infected with harmful software that makes them 
part of a “botnet” controlled by the attacker. The attacker then sends a flood of requests 
to the website from these devices, causing it to become very slow or crash, blocking 
regular users from accessing it.

Activity 5.4 Effects of denial-of-service attacks (DoS)

1.	 In groups of at most five members, pick one effect of DoS from Figure 5.6 
and discuss how denial of service can result in your chosen effect.

2.	 Present your findings to the whole class for feedback and discussion

Spoofing
Spoofing in cybersecurity is when a hacker pretends to be someone or something they 
are not, in order to deceive others and gain unauthorised access or information.

How does spoofing works?
Spoofing works by faking or pretending to be someone else to trick people into believing 
it is a trusted source. Here’s how it typically works:

1.	 Fake Identity: The person doing the spoofing will create a fake email address, 
phone number, or website that looks like it is from a real, trusted source
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2.	 Deceptive Message: They send a message (email, text, etc.) that looks official, 
asking you to do something, such as clicking a link, entering personal information, 
or downloading a file.

3.	 Since the message looks real, you might think it is safe and respond. But in reality, 
it is the attacker trying to steal your information or install harmful software on 
your device.

Types of spoofing
1.	 Email spoofing: The attacker sends an email that looks like it is from a trusted 

source such as your bank or a friend but in reality, it is not from them.

2.	 IP spoofing: The attacker fakes the IP address of their device to make it look 
like the traffic is coming from a trusted source, often to bypass security checks.

3.	 Website spoofing: A hacker creates a fake website that looks like a real one 
such as a fake login page to trick users into entering their personal information.

4.	 Caller ID or phone spoofing: The attacker makes it look like a phone call is 
coming from a trusted number when it is really from them, often used in scams.

5.	 DNS spoofing: The attacker changes the records of a domain name server 
(DNS) so that when you try to visit a website, you are sent to a fake one instead.

Now that you have gone through some common computer and information security 
risks, let us take this activity to boost your understanding of these risks, how they are 
caused, the effect they may pose on users and how they can be prevented as well as 
practices that protect our digital devices and information systems from these risks.

Activity 5.5 Computer and Information Security Risks

1.	 In groups of not more than five, pick one risk associated with using ICT, 
including internet and network attacks (cyberbullying, malware, denial-of-
service attacks) and discuss strategies for preventing and addressing your 
chosen risk.

2.	 Create a presentation to be delivered to the whole class explaining the effects 
of your chosen risk.

3.	 Deliver your presentation to the whole class.

4.	 Allow other groups to ask questions and make contributions.
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Intrusion Detection Systems (IDS)
An Intrusion Detection System (IDS) watches for any unusual or suspicious activity, 
such as someone trying to break in or cause harm. It acts as a security guard for your 
computer or network, looks out for danger and helps protect your system from threats.

How IDS works
Monitoring: The IDS constantly keeps an eye on the traffic and actions happening 
on the system or network, looking for signs of possible threats, like hackers trying to 
access your data or malicious software trying to spread.

Detection: If it detects something suspicious (like someone trying to hack into your 
system or a virus trying to enter), it raises an alert to warn the system administrators 
or security team.

Protection: While an IDS does not stop the attack directly, it helps people respond 
quickly before the damage becomes serious.

INTRUSION PREVENTION SYSTEMS (IPS)
An Intrusion Prevention System (IPS) is like an active security guard for your 
network or computer. Unlike an Intrusion Detection System (IDS), which just alerts 
you about threats, an IPS actively stops them before they can cause harm to your 
system. IPS watches for threats and actively stops them from causing damage to your 
system.

How IPS works
1.	 Monitoring: The IPS constantly monitors the network traffic and system 

activities, just like a security camera watches a building.

2.	 Detection: It looks for any suspicious activity or known patterns of attacks, like 
hackers trying to get in or harmful software trying to spread.

3.	 Prevention: When the IPS spots something dangerous, it does not just send an 
alert rather, it takes action to block the threat immediately. For example, it can 
stop harmful traffic, block the attacker’s access, or even disconnect a malicious 
device from the network.
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Activity 5.6 Differentiating between IDS and IPS.

Now that you know what IDS and IPS are and how they both work, complete 
Table 5.5 to clearing state their differences based on the given criteria in the table.

Table 5.5: Differences between IDS and IPS

Criteria IDS (Intrusion Detection System) IPS (Intrusion Prevention System)

Purpose Detects and actively stops threats

Action Alerts the user or admin about 
possible threats

Response 
to Threats

Does not stop the attack, only 
alerts

Location in 
Network

Typically placed in a “monitoring” 
position, after traffic enters the 
network

Placed in-line with the traffic flow to 
actively block threats

Impact on 
Traffic

Can delay or block traffic to prevent 
attacks

Example Alerts when someone tries to hack 
into a network

Use Used for both detection and 
prevention of attacks

Similarities between IDS and IPS
1.	 Purpose: Both IDS and IPS are designed to detect and monitor suspicious 

activities or threats on a network or system to help protect it from attacks.

2.	 Security Role: Both serve as part of a network security system, helping 
to identify potential security breaches, such as hacking attempts, malware, or 
unauthorised access.

3.	 Use of Signatures: Both systems often rely on signatures or patterns of 
known attacks to detect threats. These signatures are used to recognise malicious 
activity based on previous attacks.

4.	 Traffic Monitoring: Both IDS and IPS monitor network traffic for unusual 
or suspicious behaviour, looking for signs of attacks or malicious activities.
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Network Access Control (NAC)
It is a security system that helps control who or what can access a network. It guards 
your network, making sure only authorised devices or users are allowed in. NAC 
ensures that only trusted, secure devices and users can access your network, helping to 
prevent unauthorised access and protect against security risks.

How NAC works
1.	 Checking devices: Before allowing any device such as a computer, smartphone, 

or tablet to connect to the network, NAC checks if the device is safe. It checks 
whether the device has the latest security updates or if it is running antivirus 
software.

2.	 Granting access: If the device meets the security standards, the NAC lets it access 
the network. If not, it either blocks the device or gives it limited access to certain 
resources until it becomes secure.

3.	 Ongoing monitoring: Once the device is connected, NAC continues to monitor 
its behaviour to ensure it does not pose a threat or become compromised

Security Patch Management
This is the process of regularly updating software and systems to fix security problems 
or weaknesses. These updates are called patches, and they are released by software 
makers to protect against new threats or vulnerabilities.

How security patch management works
1.	 Identifying Vulnerabilities: Sometimes, software or systems have weaknesses 

that hackers can exploit to cause harm. When these weaknesses are discovered, 
the software maker creates a patch to fix them.

2.	 Installing Patches: Security patches are released by the software maker, and the 
system or device needs to install them. This is usually done automatically or 
manually, depending on the settings.

3.	 Regular Updates: It is important to keep applying patches regularly so that your 
systems stay protected against new security threats. This keeps everything up to 
date and less vulnerable to attacks.
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Activity 5.7 Multimedia activity on IDS/IPS/NAC/Patch management.

1.	 Click on this link to watch the video - Firewalls and IDS/IPS: Essential Tools 
for Network Security || Part 5

2.	 Make notes from the video and discuss your thoughts and findings with the 
class. .

3.	 Relate the content of the video to your experiences on IDS/IPS/NAC/Patch 
Management.

4.	 Identify its uses, advantages, and limitations, relating it to your own ideas 
and experiences.

5.	 Share your ideas with the whole class for a discussion

Activity 5.8 Research on IDS, IPS, NAC and patch management

1.	 In groups of not more than five, pick one mechanism that can reduce 
network security attacks (IDS/IPS/NAC/Patch management) and discuss 
how it works to prevent threats.

2.	 Create a presentation elaborating the benefits of your chosen mechanism 
that can reduce network security attacks.

3.	 Deliver your presentation to the whole class for feedback and discussion

4.	 Allow other groups to ask questions and make contributions.

ANTIVIRUS
An antivirus is a software program designed to protect your computer or device from 
harmful programs called viruses and other threats such as malware. These harmful 
programs can damage your device, steal your information, or make it slow.

How Antivirus Works
1.	 The antivirus checks your files and programs to see if any of them have viruses 

or other harmful software.

2.	 If it finds something dangerous, the antivirus will stop it from spreading or 
causing damage.

3.	 It helps keep your digital devices safe from new viruses by regularly updating its 
protection.

4.	 If a virus is found, the antivirus can remove it, so your device works properly 
again.
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Figure 5.6: Ways of obtaining best protection

Firewalls
A firewall is like a security guard for your computer or network. Its job is to control 
the flow of data that comes in and goes out, and decide what is safe and what is not. 
Firewalls can be a physical device that sits between your computer or network and the 
internet (Hardware-based) or a program running on your computer or device that 
checks for any bad or unwanted traffic (Software-based). They helps protect your 
system by keeping bad things out while letting the safe stuff pass through.

Figure 5.7: Hardware Firewall

Table 5.6: How software and hardware firewalls work

Software firewall Hardware firewall

When your computer wants to communicate with the 
internet such as loading a website, sending an email, or 
using an app, the firewall checks whether this action is 
safe. If it thinks the action is suspicious or harmful, it 
blocks it. (Traffic Filtering)

The hardware firewall is usually 
placed between your home or 
office network and your internet 
connection such as your router.



156

YEAR 2 COMPUTER NETWORK SECURITY AND NETWORK SECURITY RISKSSECTION 5

You can set rules on the firewall about what is allowed 
or not. For example, you might let your web browser 
and email program connect to the internet, but block 
a suspicious program from accessing the network. 
(Custom Rules)

It checks all incoming and 
outgoing data and blocks any 
harmful traffic, such as hackers 
trying to access your network.

Table 5.7: Examples of software and hardware firewalls

Software firewall Hardware firewall

Windows Defender Firewall: Built into 
Windows computers, it monitors and controls 
incoming and outgoing traffic based on a set of 
security rules.

Cisco ASA (Adaptive Security 
Appliance): A more advanced firewall 
used by businesses to protect their 
networks from cyber threats.

Figure 5.8: Deployment of a Firewall in a SOHO

Activity 5.9 Computer and Information Security Risks Prevention

1.	 In groups of not more than five, create a presentation to be delivered to 
the whole class on the need to use firewalls and antiviruses on computers 
systems and networks. In your presentation, include real-life examples to 
illustrate how these technologies protect computer systems and networks 
from threats.

2.	 Deliver your presentation to the whole class.

3.	 Allow other groups to ask questions and make contributions.
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EXTENDED READING
•	 https://www.nea.org/professional-excellence/student-engagement/tools-tips/helping-

students-deal-cyberbullies

•	 https://us.norton.com/blog/malware/types-of-malware

•	 https://www.fortinet.com/resources/cyberglossary/malware

•	 https://www.keycdn.com/support/what-is-a-botnet



158

COMPUTER NETWORK SECURITY & NETWOK SECURITY RISKS140

REVIEW QUESTIONSREVIEW QUESTIONS

1.	 What role do social media platforms play in cyberbullying?

2.	 Why is cyberbullying considered harmful?

3.	 What is the primary difference between a virus and a worm in terms of how 
they spread?

4.	 How does denial-of-service (DoS) attack affect a website or online service?

5.	 What is the difference between a DoS attack and a Distributed Denial of 
Service (DDoS) attack?

6.	 What are the limitations of using only antivirus software for network security, 
and why is a firewall necessary in addition to antivirus protection?

7.	 How do firewalls and antivirus software complement each other in protecting 
a computer network from cyber threats?

8.	 As the IT administrator of a school, outline any three technical measures 
you would recommend for your school to implement to detect and prevent 
malware-based cyberbullying incidents in the school especially those targeting 
employees or students?

9.	 Identify and explain 3 long-term financial and reputational effects of a 
successful DoS attack on a business or organisation?

10.	 Explain three ways that organisations can protect themselves from this kind 
of attack?

11.	 How can hardware theft be a security risk, and what steps can be taken to 
mitigate it?

12.	 How can firewalls be configured to provide dynamic protection against 
sophisticated, evolving threats such as Distributed Denial-of-Service (DDoS) 
attacks or advanced network infiltration tactics?
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GLOSSARY
•	 Adware: Software that displays unwanted ads, usually while you’re browsing the internet. 

It can also track user behaviour to serve targeted ads.

•	 Alignment - The way text or images are positioned (left, right, centre, or justified) 
on a webpage

•	 Architecture: The design and structure of a network, which defines how devices and 
components interact. Common architectures include Client/Server and Peer-to-Peer.

•	 Argument: The values or references that a function uses to perform its calculation.

•	 Artificial Intelligence (AI): The simulation of human intelligence in machines that are 
programmed to think and learn.

•	 Audio Player: A tool on websites that plays sound

•	 Bandwidth: The amount of data that can be sent over your internet connection

•	 Blockchain: A secure and transparent technology that records transactions in a way that 
cannot be easily altered, often used in cryptocurrency.

•	 Browser - A program used to view websites - Examples: Google Chrome, Mozilla 
Firefox, Opera

•	 Cell Reference: A way to identify a specific cell in a spreadsheet using its column letter 
and row number

•	 Centralisation: A network structure where all control, data, or resources are managed by 
a single central authority, such as a server.

•	 Chart: A chart is a visual tool used to present data in a structured format, often using bars, 
lines, or slices to compare different categories or show parts of a whole.

•	 Client: A device or program that requests and uses services or resources from a server in a 
network.

•	 Cloud Storage: A service that allows users to store their files online, so they can access 
them from anywhere, such as Google Drive or Dropbox.

•	 Communication: The exchange of data or information between devices within a network 
using protocols.

•	 Connectivity: The state of being connected within a network, enabling devices to 
communicate and share resources.

•	 Content Area - The main part of a webpage where the primary information is 
displayed - Like the main text in a textbook

•	 Controls: Buttons and tools to manage audio/video playback

•	 Credibility: The trustworthiness or reliability of a website or information source, often 
verified through reputable and official platforms.

•	 CRM (Customer Relationship Management): Software that helps businesses manage 
interactions with current and potential customers.

•	 Cyberbullying: This is the use of the internet or digital devices such as phones or 
computers) to hurt, embarrass, or threaten someone. It can happen through messages, 
social media, or online games.

•	 Data Validation: A feature that restricts the type of data that can be entered into a cell, 
helping to prevent errors before they occur.
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•	 Decentralisation: The distribution of network functions or control across multiple 
devices or nodes, without relying on a central authority.

•	 Digital Image - A picture stored as computer data - Can be a photograph, drawing, 
or graphic

•	 Digital Marketing: Promoting products or services using digital channels, such as social 
media, email, and websites.

•	 Doxing: Sharing private information about someone online without their permission, like 
their phone number or home address, to cause harm or make them feel unsafe.

•	 Enterprise Resource Planning (ERP): A system used by businesses to manage 
and integrate key parts of their operations, such as inventory, accounting, and human 
resources.

•	 Enterprise Users: Users within large organisations who use technology to manage 
and operate business processes. They often use specialised software and enterprise-
level solutions such as Enterprise Resource Planning (ERP) and Customer Relationship 
Management (CRM) systems.

•	 Error Checking: A built-in Excel tool that automatically checks for common errors in 
formulas and provides suggestions for corrections.

•	 Error Value: A message that appears when a formula or function cannot be calculated.

•	 Ethernet: A wired network technology that enables devices to communicate using 
standardized protocols over physical cables.

•	 Excel: it is a category of software used to organise data either in rows or columns.

•	 File Format - The type of file that tells the computer how to handle data - 
Examples: .jpg, .png, .gif

•	 Filtering: Filtering is the process that allows you to view only specific rows in your dataset

•	 FinTech: Technology that improves and automates the delivery of financial services.

•	 Firewall: A security system that monitors and controls incoming and outgoing network 
traffic based on predetermined security rules, often used to block unauthorised access to or 
from a private network.

•	 Formula Auditing: The process of reviewing and analysing formulas to ensure accuracy 
and correct functionality, often using built-in tools in Excel.

•	 GPS (Global Positioning System): A technology that uses satellites to determine the 
location of a device anywhere on Earth.

•	 Graph: A graph is a visual representation of data points plotted along two axes.

•	 Header: A part of a data packet that contains metadata, such as source and destination 
addresses, to facilitate its transmission and delivery in a network.

•	 Home Users: Individuals or families who use technology at home for personal tasks like 
entertainment, communication, and education.

•	 Hybrid: A network or system that combines features of multiple architectures, such as 
combining Client/Server and Peer-to-Peer models.

•	 Iferror: A function that allows users to catch errors in a formula and return a specified 
value or message instead of an error code.

•	 Infographics: Combine text, images, and data visualisations to communicate information 
engagingly and effectively.
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•	 Intrusion Detection System (IDS): A system that monitors network traffic for 
suspicious activity or known threats and alerts administrators about potential security 
breaches.

•	 Intrusion Prevention System (IPS): Similar to IDS, but with the added ability to block 
or prevent detected threats in real-time, rather than just alerting

•	 Live Streaming: Broadcasting video or audio in real-time over the internet

•	 Logical Error: An error that occurs when a formula is mathematically correct but 
produces an incorrect result due to flawed logic or assumptions.

•	 Mobile Browser: A type of browser designed for smartphones and tablets, allowing you to 
surf the internet on smaller screens with touch controls.

•	 Mobile Platform: The system on a mobile device, like Android or iOS, that lets you install 
and use apps for different tasks like messaging or browsing.

•	 Mobile Users: Individuals who primarily use mobile devices like smartphones and tablets 
for communication, web browsing, and light productivity tasks on the go.

•	 Named Range: A defined name that refers to a specific cell or range of cells, making 
formulas easier to read and reducing reference errors.

•	 Named Range: A meaningful name assigned to a cell or range of cells, making it

•	 Network: A system of interconnected devices (such as computers, servers, and 
smartphones) that share resources and communicate using communication protocols.

•	 Operator: Symbols that specify the type of calculation to perform

•	 Packet Filtering: A basic firewall technique that checks data packets (units of data 
transmitted over a network) and filters them based on predefined rules, such as allowing 
traffic from trusted IP addresses and blocking others.

•	 Peer-to-Peer Network: A decentralised network model where devices (peers) share 
resources and communicate directly without a central server.

•	 Pinch-to-Zoom: A gesture used on mobile devices to zoom in or out on a screen by 
pinching fingers together or spreading them apart.

•	 Pixel - The smallest unit of a digital image - Like tiny dots that make up a picture

•	 Power Users: Users who require more advanced computing capabilities for tasks such 
as graphic design, video editing, programming, and data analysis. They often use high-
performance devices.

•	 Pre-emptive means taking action before something happens, in order to stop it or 
prevent it from getting worse.

•	 Protocol: A set of rules or standards that define how data is transmitted and received in a 
network. Examples include HTTP, TCP/IP, and FTP.

•	 Range: A group of cells referenced in a formula or function. It can be a single cell

•	 Range: Range refers to the selected group of adjacent cells.

•	 Ransomware: A type of malware that locks a user’s files or computer and demands 
payment (ransom) for access to be restored.

•	 Real-time Protection: A feature of antivirus software that actively scans files and 
programs as they are opened or executed, blocking threats in real time.

•	 Relative Reference: A cell reference that adjusts when the formula is copied to another 
cell. For example, if a formula in cell B2 references A1, when copied to B3,

•	 Resolution: How clear and detailed a video look, measured in pixels (e.g. 1920x1080)
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•	 Responsive Web Design: A design approach where websites adjust automatically to fit 
different screen sizes, like phones, tablets, or computers.

•	 Scalability: The ability of a network or system to handle growth, such as adding more 
devices or increasing traffic, without performance degradation.

•	 Search Engine: A tool like Google that helps you find information on the internet by 
typing in keywords.

•	 Search Operators: Special characters or commands like quotation marks (“”) or “site:” to 
refine search results and make them more accurate.

•	 Server: A computer or system that provides resources, data, or services to clients over a 
network.

•	 Signature-based Detection: A method used by antivirus software to detect known 
viruses by comparing files to a database of known virus signatures (unique patterns or 
code).

•	 Small/Home Office Users: Entrepreneurs or small business owners who run their 
businesses from home and use technology for professional tasks.

•	 Social media: Online platforms where users can create and share content or participate in 
social networking (e.g., Facebook, Instagram)

•	 Sorting: Sorting is the process used to arrange data in a specified order, either 
alphabetically, numerically, or by date, to make analysis easier.

•	 Spoofing is when someone pretends to be someone else in order to trick or deceive 
people.

•	 Spyware: Malware that secretly collects information about a user or organisation without 
their knowledge, often to send it to advertisers or cybercriminals.

•	 Technology: The application of scientific knowledge for practical purposes, especially in 
industry.

•	 Trojan Horse: A type of malware that disguises itself as legitimate software to trick users 
into installing it. Once installed, it can steal data or give unauthorised access to hackers.

•	 Trolling: This is posting rude or mean comments online just to upset others and can result 
in bullying.

•	 Video Conferencing: A technology that allows users to have virtual face-to-face meetings 
using software like Zoom or Microsoft Teams

•	 Virtual Private Network (VPN): A secure network connection that allows users to send 
and receive data over the internet as if their devices were directly connected to a private 
network. Firewalls often work with VPNs to ensure safe data transmission.

•	 Virus: A type of malware that attaches itself to a program or file and spreads to other 
programs or files, often causing harm to the system.

•	 Web Address (URL): A special link that tells you where to find a website on the internet. 
For example, “https://example.com” is a web address.

•	 Web App: An app you can use directly from a browser without needing to download it. 
For example, Google Docs or Canva can be used online.
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